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1. Microsoft SharePoint Legacy Connector
Deprecated

The Coveo Legacy connector for Microsoft SharePoint allows you to bring the information stored on one or multiple
SharePoint farms into the unified index so that end-users can easily access this content. The Legacy connector
allows Coveo Enterprise Search (CES) to crawl and index a complete SharePoint farm or specific farm sections,
such as Web Applications, site collections, websites, lists, or document libraries.

Note: A second generation SharePoint connector is now available and strongly recommended to use over the
legacy version.

CES 7.0.7433+ (February 2015) A tool to convert your SharePoint Legacy sources to SharePoint sources is
available. The SharePoint Converter Tool, which is compatible with CES 7.0.6767+ (June 2014 monthly release),
is pretty useful when you want to take full advantage of the improved SharePoint connector without having to
recreate all your SharePoint Legacy sources. Contact Coveo Support to get the SharePoint Converter Tool.

1.1 Connector Features Summary

Features Supported Additional information

SharePoint version 2010, 2013,
Online,

Foundation
2010, and
Foundation

2013

Searchable content
types

Farms (tenant in SharePoint Online), Web applications, site collections,
sites, subsites, portals1, areas, area listings, user profiles1, personal
websites1, lists*, list items*, list item attachments*, document libraries,
document sets, documents, Web parts2, and microblog posts and
replies.

Note: Unpublished items are indexed.

Content
update

Incremental
refresh

Full refresh or rebuild is needed to retrieve updated (added, created,
deleted) user profiles1.

Full refresh

Rebuild

Document-level
security

* - Not supported for SharePoint Online.

1 - Not available in Microsoft SharePoint Foundation.
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2 - Not all Web parts are available in Microsoft SharePoint Foundation 2010 (seeOverview of Web Parts
available in SharePoint Foundation 2010).

1.2 Features
l Content indexing

o Indexing all SharePoint content

n Farms and Web Applications

n Site collections and sites

n Portals, areas, and area listings

Note: Portals are not available in Microsoft SharePoint Foundation.

n Lists, list items, and list item attachments

Note: Not supported for SharePoint Online.

n Document libraries, documents, and document sets

n User profiles and personal websites

Note: User profiles and personal websites are not available in Microsoft SharePoint Foundation.

n Web Parts

Note: Not all Web parts are available in Microsoft SharePoint Foundation 2010 (see Overview of
Web Parts available in SharePoint Foundation 2010).

n CES 7.0.5556+ (June 2013) Microblog posts and replies

o Automatic site collection discovery

You can configure the SharePoint Legacy connector to index all site collections located on a SharePoint
farm without having to list them manually (see SharePoint Site Discovery in Configuring and Indexing a
Microsoft SharePoint Source).

o HTTP over SSL (HTTPS) support

You can use the SharePoint Legacy connector to index a SharePoint site that uses HTTPS.

l Security

The SharePoint Legacy connector supports security for SharePoint Web Applications using Classic Mode or
Claims Based authentication.

o Classic Mode

The Legacy connector indexes permissions on SharePoint items as SharePoint groups and Windows
accounts.
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n When a user performs a query, returned results are only those to which his Windows account has
access.

n Users can perform queries from any CES search interface.

o CES 7.0.5031+ (March 2013) Claims Based (Forms, Windows [NTLM or Kerberos], ADFS)

The Legacy connector indexes permissions on SharePoint items as SharePoint groups and Claims.

n When a user performs a query, returned results are only those with permissions that match any of the
Claims assigned to the user after he is successfully authenticated in SharePoint.

n Users can perform queries from any Coveo search interface:

o When searching from within SharePoint using the Coveo search box, the user is already
authenticated in SharePoint and his Claims are available to the Coveo Search. This means that
search queries can be performed using the Claims assigned to the user.

o Claims users can also perform searches for secured SharePoint content from Coveo search
interfaces outside SharePoint without having to log in to the search interface (see "Manually
Configuring a .NET Search Interface Claims SSO for an On-Premises SharePoint" on page 95).

Note:When configuring a SharePoint Legacy connector source, you must select an Authentication Type
(see "Configuring and Indexing a Microsoft SharePoint Source With the Legacy Connector" on page 81).
The selection depends on the type of authentication used by the SharePoint Web Application Zone that
the source indexes.

The SharePoint Legacy connector supports indexing content from SharePoint Web Applications using
the following Claims authentication types:

n Windows authentication

n Form-based authentication

n CES 7.0.5556+ (June 2013) Trusted identity provider (ADFS)

l Incremental refresh

Once incremental refresh is enabled on a SharePoint source, the SharePoint Legacy connector automatically
refreshes the content modified since the last incremental refresh run. This way, the index is always kept up to
date.

l SharePoint Integration:

o Installation of Coveo Web Service on the SharePoint server to provide more crawling functions

o Installation of the Coveo search box to replace the SharePoint search box

o Installation of Coveo search interfaces on the SharePoint server

l Intranet and SharePoint search interface features related to the SharePoint Legacy connector:
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o Search results folding for the following SharePoint items:

n Blog posts and their comments

n Discussion board threads

n Document sets and their items

o The Document Sets facet appears, listing all document sets included in the results when one or more
document set items match the query.

o Search results referring to a document link in SharePoint are now identified with a special icon.

Feature history

CES 
version

Monthly
release

Features

7.0.6830 July
2014

Source and security provider types renamed from SharePoint to SharePoint Legacy with
the introduction of the second generation SharePoint connector.

7.0.6424 February
2014

Search interface with Claims SSO (see "Manually Configuring a .NET Search Interface
Claims SSO for an On-Premises SharePoint" on page 95)

7.0.5556 June
2013

l Beta support for SharePoint 2013 Online.

l Support Conversations (Micro-Blogging)

l Trusted identity provider (ADFS)

7.0.5031 March
2013

Beta support for an on-premises SharePoint 2013 and SharePoint 2010 Online.
Claims-based authentication for any search interface.

7.0.4855 August
2012

Support for Claims-based authentication for search interfaces integrated in SharePoint
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2. Microsoft SharePoint Legacy Connector Deployment
Overview
Deprecated

The following procedure outlines the steps needed to deploy the Microsoft SharePoint Legacy connector. The steps
indicate the order in which you must perform configuration tasks in Microsoft SharePoint and CES.

Note: It is strongly recommended to rather use the second generation SharePoint connector.

1. Validate that your environment meets the requirements (see "Microsoft SharePoint Legacy Connector
Requirements" on page 7).

2. Identify if the SharePoint environment you want to index is a Classic, Claims, or Online type (see "Identifying
Your SharePoint Environment" on page 8).

3. On your SharePoint farm (tenant in SharePoint Online):

a. Select or create a user that the Legacy connector will use to crawl your SharePoint content. The type of
user depends on the type of SharePoint environment (see "Type of User to Specify for the User Identity" on
page 9).

b. Grant appropriate SharePoint permissions to the crawling account you selected (see "Granting SharePoint
Permissions to the Crawling Account" on page 10).

c. For on-premises environments, install the Coveo web service, search box, and search interface on your
SharePoint farm (see "Installing the Coveo Web Service, Search Box, and Search Interface into
SharePoint" on page 29).

Note:With this installation procedure, you can also integrate the Coveo search box to SharePoint. This is
not needed to deploy the Legacy connector and can be done later.

4. On the Coveo Master server, in the Administration Tool:

a. Configure the user identity

Once the crawling account has been set up, you must create a CES user identity for this account.

b. When indexing SharePoint Online content, you must install the Windows Azure AD module on the Coveo
Master server because it is needed by the Office 365 security provider (see "Installing the Windows Azure
AD Module for Windows PowerShell" on page 72).

c. Determine which security providers are required for your SharePoint environment (see "Security Providers
to Use" on page 8).

Create the required ones:
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l "Creating a Claims Security Provider for an On-Premises SharePoint" on page 52

l "Creating a Claims Security Provider for SharePoint Online" on page 57

l "Creating an Office 365 Security Provider for SharePoint Online" on page 73

l "Creating a Security Provider for the SharePoint Legacy Connector" on page 76

d. Configure and index the Microsoft SharePoint source

The Coveo Legacy connector needs to know details about your Microsoft SharePoint server or farm
(tenant in SharePoint Online) to be able to index its content (see "Configuring and Indexing a Microsoft
SharePoint Source With the Legacy Connector" on page 81).

5. When you provide a Coveo .NET search interface residing outside SharePoint and want users to be able to
find Claims-secured SharePoint content without having to log in again to SharePoint, configure the search
interface to manage single sign-on (see "Manually Configuring a .NET Search Interface Claims SSO for an On-
Premises SharePoint" on page 95).
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3. Microsoft SharePoint Legacy Connector Requirements
Deprecated

Your environment must meet the following requirements to be able to use the Coveo Legacy connector for Microsoft
SharePoint.

3.1 Requirements
l Coveo license for the Microsoft SharePoint Legacy connector

Your Coveo license must include support for the Microsoft SharePoint Legacy connector to be able to use this
connector.

l Appropriate SharePoint permissions for the crawling account (see "Granting SharePoint Permissions to the
Crawling Account" on page 10).

Note: For environment using Claims, also refer to the Claims security provider requirements (see "ADFS Server
Requirements for a Claims Security Provider" on page 60).

3.2 SharePoint Supported Versions
l SharePoint Online

l SharePoint 2013

o CES 7.0.5031+ (March 2013) On-premises (Beta)

o Microsoft SharePoint Foundation 2013

l SharePoint 2010

o Microsoft SharePoint Foundation 2010 (WSS 4)

o Microsoft SharePoint 2010 (SharePoint 2010)

l SharePoint 2007

o Windows SharePoint Services 3.0 (WSS 3)

o Microsoft Office SharePoint Server 2007 (MOSS 2007)

Note: The Coveo Platform 7 does not support the legacy SharePoint 2003.

What'sNext?

Select or create a user that the Legacy connector will use to crawl your SharePoint content, and then grant
appropriate SharePoint permissions to this crawling account (see "Granting SharePoint Permissions to the
Crawling Account" on page 10).
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4. Identifying Your SharePoint Environment
Deprecated

The SharePoint Legacy connector supports on-premises and online SharePoint versions (see "Microsoft
SharePoint Legacy Connector Requirements" on page 7). The connector components to deploy vary depending on
the SharePoint environment being indexed.

Before starting to deploy the Legacy connector, you must refer to the following table and identify the SharePoint
environment type from which you want to index content (Classic, Claims, or Online).

SharePoint
environment type

SharePoint
Version

Online 2013 2010 2007

Web app
authentication

Office 365
Native

Claims-
based

Claims-
based

Classic
Windows

Claims-
based

Classic
Windows

Classic ✓ ✓

Claims ✓ ✓

Online ✓ ✓

4.1 Security Providers to Use
Your SharePoint environment to index determines the required security providers that you must create.

SharePoint environment

Required security provider type Classic Claims Online

SharePoint ✓ ✓ ✓

Active Directory ✓ ✓ ✓

Claims for SharePoint On-premises ✓

Claims for SharePoint Online ✓

Office 365 ✓

Note:When you want to index content from different SharePoint environments, you must create multiple
SharePoint security provider and source instances, each one with its own configuration.
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4.2 Type of User to Specify for the User Identity
Your SharePoint environment to index determines the type of user that you must specify in a User Identity to allow
the Legacy connector and security provider to crawl your SharePoint content.

SharePoint
environment

Enabled
authentication

Type of user Example

Classic Windows Windows account acme\john
john@acme.com

Claims Windows Windows account acme\john
john@acme.com

Form Format expected by the login
form

ADFS Federated by ADFS acme\john

john@acme.com

Online Native Native Office 365 account john@acme.onmicrosoft.com

SSO Single Sign-On Office 365
account

john@acme.com

Note: You will create a User Identity with the credentials of the selected user. You will then assign the User
Identity to one or more security providers and to the source.

What'sNext?

Grant appropriate SharePoint permissions to the selected crawling account (see "Granting SharePoint Permissions
to the Crawling Account" on page 10).
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5. Granting SharePoint Permissions to the Crawling Account
You must select an existing account or create a new one that the SharePoint, SharePoint Legacy or OneDrive for
Business (CES 7.0.8047+ (December 2015)) connector will use to crawl your SharePoint or OneDrive for Business
content.

Tip: The best practice is to create a dedicated account for the exclusive use of the Coveo connector with a
password that never changes. If you must change the password of this account you will need to change it both in
the original identity provider system (AD or other) and in the corresponding CES user identity.

This crawling account must have the proper rights to retrieve the information from your SharePoint farm (tenant in
SharePoint Online). There are two methods to configure the necessary SharePoint permissions for the crawling
account.

l "Automatic Permissions Setup" on page 10

l "Manual Permissions Setup" on page 10

5.1 Automatic Permissions Setup
The SharePoint and SharePoint Legacy connectors have the ability to automatically set the required permissions to
allow the crawling account to gain read access to the whole content as long as the following requirements are met:

l For SharePoint 2016, 2013, Foundation 2013, 2010, Foundation 2010, and 2007 (Not for SharePoint Online)

l The Coveo SharePoint web service must be installed on the SharePoint farm (see "Installing the Coveo Web
Service, Search Box, and Search Interface into SharePoint" on page 29)

l The crawling account must:

o Be a member of the SharePoint farm administrators group (see "Adding the Crawling Account to the
SharePoint Farm Administrators Group" on page 19)

o Have the Read permission for the site collection(s) that you want to index (see "Adding the SharePoint
Website Read Permission" on page 14).

5.2 Manual Permissions Setup
When your SharePoint environment does not meet the requirements for the automatic method, you must manually
set permissions for your SharePoint crawling account.

The following table presents the minimal required permissions that the crawling account must have to perform the
specified action for the supported SharePoint versions.

Note: CES 7.0.8047+ (December 2015) For OneDrive for Business, follow the actions applicable to your
SharePoint version.
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SharePoint version
Action to perform Minimal required permission

Online 2016 2013 2010 2007

✓

Content and Security indexing,
incremental refresh, and site
collection discovery

l CES 7.0.8047+ (December 2015)
(Only when you index the
content of a SharePoint web
application) SharePoint
Administrator permission in
Office 365 (see Assigning
admin roles in Office 365).

l Administrator permission for
all SharePoint Online site
collections, including the root
site collection (see "Granting
the Site Collection
Administrator Permission in
SharePoint Online" on page
23).

✓ ✓ ✓ ✓

Full Read policy for all SharePoint
farm web applications (see
"Adding the Full Read Policy to All
SharePoint Farm Web
Applications" on page 12).

✓ ✓ ✓ ✓

Personal site, user profile and
social tags indexing

Notes:
l When indexing personal sites
or user profiles, the crawling
account must not have a
personal site on the
SharePoint server being
indexed to prevent connector
failure cases when
attempting to retrieve the list
of personal sites.

l Personal sites and user
profiles are not included in
SharePoint Foundation.

Read permission for the site
collection of the source starting
address (see "Adding the
SharePoint Website Read
Permission" on page 14).

✓ ✓ ✓

Retrieve People Data for Search
Crawlers permission to the User
Profile Service Application (see
"Adding the Retrieve People Data
for Search Crawlers Permission to
the User Profile Service
Application" on page 16).

✓

Manage user profiles permission
to the Shared Service Rights (see
"Adding the Manage User Profiles
Permission in Shared Service
Rights" on page 18).

✓

Owner of all personal sites
collections (see "Adding the
Personal Sites Collections Owner
Permissions for SharePoint Online"
on page 24).
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What'sNext?

Once you granted the appropriate permissions:

l (For SharePoint on-premises versions only) Optionally install the Coveo SharePoint web service (see
"Installing the Coveo Web Service, Search Box, and Search Interface into SharePoint" on page 29).

l (For SharePoint sources only) Create and index a SharePoint source.

l (For OneDrive for Business sources only) Create and index a OneDrive for Business source.

5.3 Adding the Full Read Policy to All SharePoint FarmWeb Applications
You must add the Full Read policy to all SharePoint farm web applications for the crawling account when you want
to perform SharePoint content and security indexing, incremental refresh, and site collection discovery.

The procedure applies to SharePoint 2013, 2010, and 2007 and varies depending on the SharePoint version:

l "Microsoft SharePoint 2013 or 2010" on page 12

l "Microsoft SharePoint 2007" on page 13

Note: The permissions required for the crawling account in the case of SharePoint Online are different.

5.3.1Microsoft SharePoint 2013 or 2010

1. Access SharePoint 2013/2010 Central Administration (Windows Start menu > All Programs > Microsoft
SharePoint 2013/2010 Products).

2. In SharePoint 2013/2010 Central Administration, under Application Management, click Manage web
applications.

3. For each web application to crawl:

a. In theWeb Applications Management page:

i. Click the name of the desired web application to highlight it.

ii. In the ribbon, click User Policy.

b. In the Policy for Web Application dialog box, click Add Users.

c. In the Add Users wizard:
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i. In the Zone drop-down list, select (All zones), and then click Next.

ii. In the Users text box, add the crawling account.

iii. Under Permissions, select the Full Read - Has full read-only access check box.

iv. Click Finish.

d. In the Policy for Web Application dialog box, click OK.

5.3.2Microsoft SharePoint 2007

1. Access SharePoint 3.0 Central Administration (Windows Start menu > All Programs > Microsoft Office
Server).

2. Click Application Management.

3. Click Policy for Web application.

4. For every web application to crawl:

a. Click Add Users.

b. Select (All Zones), and then click Next.

c. In the Users text box, add the crawling account.
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d. Under Permissions, select the Full Read - Has full read-only access checkbox, and then click Finish.

5.4 Adding the SharePoint Website Read Permission
You must add the SharePoint site Read permission to the crawling account when you want to:

l Perform SharePoint personal site and user profile indexing.

l Take advantage of the automatic permission setup feature of the SharePoint connector (see "Automatic
Permissions Setup" on page 10).

The procedure applies to SharePoint 2013, 2010, and 2007 and varies depending on the SharePoint version:

l "Microsoft SharePoint 2013 or 2010" on page 14

l "Microsoft SharePoint 2007" on page 15

5.4.1Microsoft SharePoint 2013 or 2010

1. Access the SharePoint site collection that you want to index.

2. Click the gear icon (SharePoint 2013) or the Site Actions (SharePoint 2010), and then select Site
Permissions.

3. In the ribbon, click Grant Permissions.

4. In the Grant Permissions dialog box:
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a. In the Users/Groups text box, add the crawling account.

b. Under Grant Permissions, select the Grant users permission directly radio button, and then select the
Read - Can view pages and list items and download documents check box.

c. Click OK.

5.4.2Microsoft SharePoint 2007

1. Access the SharePoint site collection site collection that you want to index.

2. Click Site Actions, and then select Site Settings.

3. Click Advanced Permissions in the Users and Permissions column.

4. Click New.

5. In the Add Users page:
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a. In the Users/Groups text box, add the crawling account.

b. Under Give Permission, select the Give users permission directly radio button, and then select the
Read - can view only check box.

c. Click OK.

5.5 Adding the Retrieve People Data for Search Crawlers Permission to the
User Profile Service Application
You must add the Retrieve People Data for Search Crawlers permission to the User Profile Service application for
the crawling account when you want to perform SharePoint personal site and user profile indexing. This procedure
applies only to SharePoint 2013 and 2010.

To add theRetrieve PeopleData for SearchCrawlers permission to theUser Profile Service
application

1. Access SharePoint 2013/2010 Central Administration (Windows Start menu > All Programs > Microsoft
SharePoint 2013/2010 Products).

2. In the SharePoint 2013/2010 Central Administration, under Application Management, click Manage service
applications.

3. In the Manage Service Applications page:
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a. Without clicking it, highlight User Profile Service Application.

Note:When User Profile Service Application is not present in the service applications list, the User
Profile Service Applicationmay not be installed on your SharePoint farm, and there is therefore no
people data to index. Abort this procedure.

b. In the ribbon, click Administrators.

4. In the Administrators for User Profile Service Application dialog box:
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a. In the first box, type the crawling account, and then click Add.

b. In the second box, select the crawling account.

c. In the Permission for Administrators list, select the Retrieve People Data for Search Crawlers check
box, and then click OK.

5.6 Adding the Manage User Profiles Permission in Shared Service Rights
You must add the Manage user profiles to Shared Service Rights for the crawling account when you want to
index SharePoint personal sites and user profiles. This procedure applies only to MOSS 2007 (SharePoint 2007).

To add theManage user profiles permission to SharedServiceRights

1. Access SharePoint 3.0 Central Administration (Windows Start menu > All Programs > Microsoft Office
Server).

2. Click Shared Services Administration.

3. Click the shared service link hosting the user profiles and personal sites data.

4. Click Personalization service permissions.

5. Click Add Users/Groups.

6. In the Add Users/Groups: Shared Service Rights page:

a. In the Users/Groups text box, add the crawling account.

b. In the Choose Permissions section, select the Manage user profiles check box.

c. Click Save.
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5.7 Adding the Crawling Account to the SharePoint Farm Administrators Group
You must add the crawling account to the SharePoint farm administrators group when you want to:

l Install the Coveo SharePoint web service (see "Installing the Coveo Web Service, Search Box, and Search
Interface into SharePoint" on page 29).

l Take advantage of the automatic permissions setup feature of the SharePoint connector (see "Automatic
Permissions Setup" on page 10).

The procedure varies depending on the SharePoint version:

l "Microsoft SharePoint 2013" on page 19

l "Microsoft SharePoint 2010" on page 20

l "Microsoft SharePoint 2007" on page 21

5.7.1Microsoft SharePoint 2013

1. Access SharePoint 2013 Central Administration (Windows Start menu > All Programs > Microsoft
SharePoint 2013 Products).

2. In the SharePoint Central Administration: 

a. In the Central Administrationmenu on the left, select Security.

b. In the Security page, under Users, click Manage the farm administrators group.

c. In the People and Groups - Farm Administrators page, click New.

d. In the Share 'Central Administration' dialog box, in the Add people to the Farm Administrators group
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box, add the crawling account, and then click Share.

5.7.2Microsoft SharePoint 2010

1. Access SharePoint 2010 Central Administration (Windows Start menu > All Programs > Microsoft
SharePoint 2010 Products).

2. In SharePoint 2010 Central Administration, under Security, selectManage the farm administrators group.

3. In the People and Groups page, click New.
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4. In the Grant Permissions dialog box, in the Users/Groups box, add the crawling account, and then click OK.

5.7.3Microsoft SharePoint 2007

1. Access SharePoint 3.0 Central Administration (Windows Start menu > All Programs > Microsoft Office
Server).

2. Click Operations.

3. Click Update farm administrator's group.

4. Click New.

5. In the Add Users page:
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a. In the Users/Groups text box, add the crawling account.

b. Under Give Permissions:

i. Select the Add users to a SharePoint group radio button.

ii. In the drop-down list, select Farm Administrators [Full Control].

iii. Click OK.

5.8 Adding the Crawling Account to the SharePoint Server Local Administrators
Group
You may need to add the crawling account to the SharePoint server local Administrators group when you want to:

l Perform SharePoint personal site and user profile indexing, incremental refresh, and site collection discovery
(see "Granting SharePoint Permissions to the Crawling Account" on page 10).

l Install the Coveo SharePoint web service (see "Installing the Coveo Web Service, Search Box, and Search
Interface into SharePoint" on page 29).

Note: This procedure applies to Microsoft Windows Server 2008.

To add the crawling account to the SharePoint server local administrator group

1. On the SharePoint server, access the Computer Management console (Windows Start menu > All
Programs > Administrative Tools).

2. In the panel on the left, expand System Tools > Local Users and Groups, and then click Groups.
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3. In the panel on the right, right-click Administrators, and then click Add to Group.

4. In the Administrators Properties dialog box:

a. Click Add.

b. In the Select Users, Computers, or Groups dialog box, enter the crawling account, and then click OK.

a. Click OK to close the Administrators Properties dialog box.

5.9 Granting the Site Collection Administrator Permission in SharePoint Online
In SharePoint Online, the CES crawling account must be an administrator in Office 365 (CES 7.0.7914+ (October
2015)) and an administrator of all SharePoint Online site collections from which you want to index content, but also
the root site collection.

This high level permission is required because SharePoint Online currently does not offer lower level permissions
that allow to crawl site collection content. The root site collection administrator permission is needed by the
SharePoint auto discovery mechanism that the Coveo connector uses for operations such as detecting refreshed
and deleted folders and crawling.

Grant the administrator permission using SharePoint Online admin center

1. Access SharePoint Online administration center (https://your_domain-admin.sharepoint.com).

2. Click Manage site collections.

3. In the navigation panel on left, click Site Collections.

4. In the panel on the right, under Site Collections, select one or more site collections you want to crawl.

5. In the tool bar, click Owners, and then Manage Administrators.
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6. Add the crawling account to the list of Site Collection Administrators.

7. Click OK.

What'sNext?

CES 7.0.7914+ (October 2015) Assign the admin role to your crawling account in Office 365 (see Assigning admin
roles in Office 365).

5.10 Adding the Personal Sites Collections Owner Permissions for SharePoint
Online
You must make the crawling account an owner of all the personal sites collections when you want to index
SharePoint Online personal sites and user profiles. The crawler will only be able to index content from a personal
site if the crawling account is an owner of this personal site, other personal sites for which it is not an owner will be
ignored.

You can add these permissions using one of the following methods:

l Using the admin center (SharePoint Online 2010 and 2013)

SharePoint Online admin center allows granting owner permissions for only one personal site collection at a
time, which means this procedure has to be done for every personal site collection.

l Using a PowerShell script (SharePoint Online 2013 only)

A PowerShell script using SharePoint Online cmdlets is available to facilitate the task of granting owner
permissions to a specific account for all personal site collections.

To add theOwner permission using SharePoint Online admin center

1. Access SharePoint Online administration center (https://your_domain-admin.sharepoint.com).

2. In the navigation panel on the left, click user profiles.

3. Click Manage User Profiles.

4. Use the search box to find the user profiles of the users you want to crawl.
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5. Right-click an Account Name and then selectManage site collection owners.

6. Add the crawling account to the list of Site Collection Administrators.

7. Click OK.
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To grant theOwner permission using SharePoint OnlineManagement Shell

Notes:

l You must regularly perform the following procedure when you want to grant permissions for site collections of
new users.

l This procedure applies to SharePoint Online only.

1. Install SharePoint Online management shell (see the Microsoft document Set up the SharePoint Online
Management Shell Windows PowerShell environment).

2. Download the zipped COVEOSPO.PS1 script file to the server where the SharePoint Online
management shell was previously installed.

Important: The script was updated on January 21, 2016.

3. Unzip the file.

4. On the Windows menu select Start > All Programs > SharePoint Online Management Shell.

5. Load the COVEOSPO.ps1 script.

Example: $> . C:\script\COVEOSPO.ps1

6. Run the Set-COVEOSPOMySitesOwner and Set-COVEOSPOSitesAdmin cmdlets.

The following table lists the parameters supported by each of the cmdlets:

Parameter and definition
Set-

COVEOSPOMySites

Owner

Set-

COVEOSPOSitesA

dmin

AdminSiteUrl
Specifies the URL of the SharePoint Online tenant. ✓ ✓

AdminUsername
Specifies the username of the SharePoint Online global
administrator used to connect to the SharePoint server. This user
will be added to the sites collection administrators (for the Set-
COVEOSPOMySitesOwner cmdlet) or the personal sites
administrators (for the Set-COVEOSPOSitesAdmin cmdlet) if the
NewAdminUsername parameter is empty.

✓ ✓

AdminPassword
Specifies the password of the SharePoint Online global
administrator used to connect to the SharePoint server.

✓ ✓

UsersDomainName
Specifies the domain of the users from which to retrieve personal
sites.

✓
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Parameter and definition
Set-

COVEOSPOMySites

Owner

Set-

COVEOSPOSitesA

dmin

NewAdminUsername
Specifies the username of one or more SharePoint Online users
and/or group(s) to be added in the sites collection administrators
(for the Set-COVEOSPOMySitesOwner cmdlet) or the personal
sites administrators (for the Set-COVEOSPOSitesAdmin cmdlet).
If not set, the user specified in the AdminUsername parameter
will be added.

Notes:
l You can add user and group at the same time by
separating values with comma.

Example: -NewAdminUsername
"user1@domain.com","user2@domain.com","c:0-.
f|rolemanager|s-[accountNumber]"

l You must find the group ID to add the associated users in
the sites collection or personal sites administrators (see To
find a SharePoint group ID).

✓ ✓

Remove
This parameter is a switch that, when included in the script,
removes the user(s) and/or group(s) specified in the
NewAdminUsername parameter (instead of adding them) from
the sites collection administrators (for the Set-
COVEOSPOMySitesOwner cmdlet) or the personal sites
administrators (for the Set-COVEOSPOSitesAdmin cmdlet).

✓ ✓

Examples:

l $> Set-COVEOSPOMySitesOwner -AdminSiteUrl https://acme-admin.sharepoint.com -

AdminUsername admin@acme.onmicrosoft.com -AdminPassword password -UsersDomainName

acme.onmicrosoft.com

l $> Set-COVEOSPOSitesAdmin -AdminSiteUrl https://acme-admin.sharepoint.com -

AdminUsername globaladmin@acme.onmicrosoft.com -AdminPassword password -

NewAdminUsername "user@acme.onmicrosoft.com", "c:0-.f|rolemanager|s-1-5-21-

2644810858-3409521387-2709630237-4818302"

To find aSharePoint group ID

1. If not already done, repeat the procedure to add the Owner permission using SharePoint Online admin center
to the group, but without performing the last step.

2. In the site collection owners panel, access the source code of the page by pressing F12 or by right-clicking,
and then selecting Inspect (Google Chrome) or View Page Source (Firefox).

3. In the window that appears, in the source code, prior to displaytext='GroupName', copy the value of the
key parameter (key='GroupID').
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You can now paste the group ID in the NewAdminUsername parameter to add/remove the group members
in/from the sites collection or personal sites administrators.

4www.coveo.com 28

http://www.coveo.com/


Coveo Platform 7.0 | Microsoft SharePoint Legacy Connector Guide

6. Installing the CoveoWeb Service, Search Box, and
Search Interface into SharePoint
The Coveo .NET Front-End can be integrated to an on-premises SharePoint by installing the following Coveo
SharePoint web service, the Coveo search box, and the Coveo search interfaces components on all your
SharePoint front-end servers.

Note: CES 7.0.9093+ (September 2017) If you plan on creating a JavaScript search page and want to leverage
claims from your on-premises SharePoint farm, you can install the Coveo Claims Security Module rather than the
Coveo .NET Front-End web service (see Allowing a JavaScript Search Page to Retrieve SharePoint Claims).

Important: Do not install both the Coveo Claims Security Module and the Coveo .NET Front-End web service, as
this would create dupplicate files on your server.

Coveo SharePoint web service

The optional Coveo SharePoint web service installed on a SharePoint server enhances the Coveo SharePoint,
SharePoint Legacy and OneDrive for Business (in a SharePoint 2013 or 2016 scenario) connectors ability to
extract and index SharePoint content by providing:

l Full site collections discovery of the targeted SharePoint farms

l Automatic crawling account configuration (see "Automatic Permissions Setup" on page 10)

l Possibility for end-users to log with SharePoint credentials in a Coveo search interface deployed outside of
your SharePoint farm so that they can see SharePoint search results.

Note: Coveo .NET Front-End 12.0.99+ (March 2013) The Coveo SharePoint web service is optional only
when all the content is indexed from a Classic SharePoint environment.

When indexing content from Web Applications using Claims-based Authentication Providers, the web service
must be installed on the SharePoint server in order to add the following new features required by the Coveo
Back-End and Mirror servers to handle Claims permissions:

l Convert permissions found on SharePoint document into Claims.

l Retrieve the list of Claims associated to a user performing a search in CES.

Coveo search box

You can also install the control for the Coveo search box on a SharePoint server and use it to replace the
default SharePoint search box to get the benefits of the Coveo search results directly within SharePoint,
providing another convenient Coveo access point.

Note: Installing the Coveo search box on the SharePoint server is optional and is not needed to deploy the
Coveo SharePoint, SharePoint Legacy or OneDrive for Business (in a SharePoint 2013 or 2016 scenario)
connector.
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Tip:When the Coveo search box is installed on the SharePoint server, from the Interface Editor you can
activate the Enable search as you type option in your SharePoint search interfaces to get quick search
results directly under the search box. Note that you must install the Default Search Interface to gain access to
the Interface Editor.

Coveo search interfaces

When you choose to install the Coveo search box on your SharePoint server, you must also install Coveo
search interfaces on the SharePoint server to present search results for queries performed from the Coveo
search box.

Tip: You can configure the scope of each search interface using the Interface Editor.

Important: You must perform the following installation procedure for each web front-end server of your
SharePoint farm, one after the other. You may see the An update conflict has occurred, and you must

re-try this action. error message when installing concurrently on more than one server. You must also
repeat this procedure each time you update or migrate the Coveo Platform on your Coveo Master server.

To install theCoveo SharePoint web service, search box, and search interface

1. Using a local administrator account, connect to the web front-end server of your SharePoint farm.

2. Ensure that the account you are using has the permissions presented in the following table.
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SharePoint version
Required permissions

2016/2013/2010 2007

✓ ✓

Member of the SharePoint server local Administrators group (see "Adding the
Crawling Account to the SharePoint Server Local Administrators Group" on page
22)

✓ ✓

l Have the SQL Server system administrator server role (see "Adding the
Microsoft SQL Server System Administrators Role" on page 37)
OR

l Have the database owner role for the SharePoint configuration database
and for all SharePoint content databases, including the Central
Administration content database (see "Adding the Database Owner Role for
Microsoft SQL Server" on page 39)

✓
Member of the SharePoint farm administrators group (see "Adding the Crawling
Account to the SharePoint Farm Administrators Group" on page 19)

3. Run the Coveo .NET Front-End installer.

4. When a required version of Microsoft Chart Controls for Dotnet Framework is missing on the server, in the
dialog box that appears, click Install.

5. When a required version of Microsoft .NET Framework is missing on the server, in the dialog box that appears,
click Install.

Note: The Microsoft components are installed through the Internet. When the installer does not have access
to the Internet, prerequisite installations will fail. You must then install the components manually and restart
the Coveo .NET Front-End installer.

6. In the installer welcome screen, click Next.

7. In the installer License Agreement screen, read the license terms, select I accept the terms in the license
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agreement, and then click Next.

8. In the Installing Folders screen:

a. For each optional item in the list, click , and then ensure This feature will be installed on local hard
drive. is selected for those that you want to install:

l Search Interface - To install the search interface libraries used to handle search queries.

l Default Search Interface - To install the default Coveo Enterprise Search web application and gain
access to the Interface Editor.

Note:When the Default Search Interface is not installed, you may get the The resource cannot

be found error message when trying to access the Interface Editor from the search interface menu
(Domore > Edit this interface).

l SharePoint Web Service - Needed to allow the connector to automatically set permissions for the
crawling account and to discover all site collections in the SharePoint farm.

l SharePoint Search Interface - Needed when you want to integrate the Coveo SharePoint search
interface in your SharePoint site.

l Coveo Search Box - Needed when you want to replace the default SharePoint search box by the
Coveo search box.
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Tip: Once installed on your SharePoint server, you can enable/disable the Coveo search box
independently for each site (see "Activating or Deactivating the Coveo .NET Search Box in a
SharePoint Site" on page 35).

b. Click Next.

9. When you install the search interface and the search box, in the Configuration screen:

a. Click Configure next toWeb site hosting the interfaces.

b. In theWeb Interface Configuration screen:

i. In theWeb site name box, enter the name of the site to be created in IIS to host Coveo search
interfaces.

ii. In theWeb site port box, enter the port to access the Coveo search interfaces. The default is 8080.

iii. Click OK.

c. Back in the Configuration screen, click Configure next to Coveo Enterprise Search server and port.

d. In the CES Configuration screen:
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i. In the Server name box, enter the hostname of the Coveo Back-End server (where CES is installed)
to which you want to connect this Front-End server. You can leave localhost when CES is also
installed on the current server.

ii. In the Service port box, change the CES service port default (52810) only when needed.

iii. Click Test Server to validate that the CES service is responding and compatible with the Coveo
.NET Front-End you are installing.

iv. In the dialog box that appears, review the message to validation is successful, and then click OK.

v. Back in the CES Configuration screen, click OK.

e. Click Next.
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10. In the installer Installing the program screen, click Install.

Coveo .NET Front-End 12.0.1548+ (June 2016) In a SharePoint farm with multiple Web Front-End (WFE)
servers, you must install or update the Coveo .NET Front-End on each server. You can however speed up the
installation by performing the changes to the SharePoint database only from the first server.

11. In the installer Installation Successful screen, click Finish.

What'sNext?

l When you install the Coveo Front-End for the first time on a server, before you can use the search interfaces,
you must link the Coveo Front-End to a Coveo Back-End server. In this case, the Coveo .NET Front-End
installer automatically opens the Front-End Server Configuration page (see "Coveo .NET Front-End First Time
Setup" on page 42).

l Create the appropriate security provider.

6.1 Activating or Deactivating the Coveo .NET Search Box in a SharePoint Site
Once you installed the Coveo .NET search box on a SharePoint server (see "Installing the Coveo Web Service,
Search Box, and Search Interface into SharePoint" on page 29), you can activate/deactivate the Coveo .NET search
box independently for each SharePoint site.

Note: SharePoint 2016/2013/2010/2007 offers a mechanism, called DelegateControl that allows administrators
to replace controls displayed in SharePoint pages. The Microsoft search box and scope selector are in the same
DelegateControl called SmallSearchInputBox. The Coveo installer deploys a feature called
CoveoSearchBox to replace the Microsoft controls in the SmallSearchInputBox.

To activate or deactivate theCoveo .NET search box in a SharePoint 2013 and 2016 site

1. Using a browser, access the SharePoint site into which you want to change the state of the Coveo search box.

Note: You can activate the Coveo Search Box feature on any of the four SharePoint levels (Farm, WebApp,
SiteCollection, and Site). Ensure to activate the Coveo search box everywhere you want it to replace the
Microsoft default search boxes.

Example: Activate the Coveo search box feature at the Farm level, to activate it all over your SharePoint
installation.

2. On the Gear menu, select Site Settings.
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3. In the page that appears, under Site Collection Administration, click Site collection features.

4. In the Site Settings > Site Collection Features page, locate Coveo Site Collection Search, and then click
Activate or Deactivate on the corresponding line.

To activate or deactivate theCoveo search box in a SharePoint 2010 site

1. Using a browser, access the SharePoint site into which you want to change the state of the Coveo search box.

Note: You can activate the Coveo Search Box feature on any of the four SharePoint levels (Farm, WebApp,
SiteCollection, and Site). Ensure to activate the Coveo search box everywhere you want it to replace the
Microsoft default search boxes.

Example: Activate the Coveo search box feature at the Farm level, to activate it all over your SharePoint
installation.

2. On the Site Actions menu, select Site Settings.

3. In the Site Settings page, under Site Collection Administration, click Site collection features.

4. In the Site Collection Administration > Features page, locate Coveo Site Collection Search, and then click
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the Activate or Deactivate button on the corresponding line.

6.2 Adding the Microsoft SQL Server System Administrators Role
The CES administrative account must be a member of the Microsoft SQL Server system administrators server role
when you want to install the Coveo SharePoint web service (see "Installing the Coveo Web Service, Search Box,
and Search Interface into SharePoint" on page 29).

The procedure applies to Microsoft SQL Server 2008, 2005, and 2000 but varies depending on the SQL Server
version:

l "Microsoft SQL Server 2008 and 2005" on page 37

l "Microsoft SQL Server 2000" on page 38

6.2.1Microsoft SQLServer 2008 and 2005

1. Access SQL Server Management Studio (Windows Start menu > All Programs > Microsoft SQL Server
2008 or Microsoft SQL Server 2005).

2. In the panel on the left, expand localhost > Security, and then click the Logins node.

3. When the login for the CES administrative account already exists, double-click it. Otherwise, right-click Logins,
and then click New Login.

4. In the Login - New dialog box:

a. In the Login Name box, enter the CES administrative account.

b. In the panel on the left, click Server Roles.
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c. In the panel on the right, in the Server roles list, select sysadmin.

d. Click OK.

6.2.2Microsoft SQLServer 2000

1. Access SQL Server Enterprise Manager (Windows Start menu > All Programs > Microsoft SQL Server).

2. In the panel on the left, expand Microsoft SQL Servers > SQL Server Group > [your server group] > Security.

3. Click the Logins node.

4. When the login for the CES administrative account already exists, double-click it. Otherwise, right-click Logins,
and then click New Login.

5. In the SQL Server Login Properties - New Login dialog box: 

a. In the Login Name box, enter the CES administrative account.

b. Click the Server Roles tab.
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c. In the Server Role list, select System Administrators.

d. Click OK.

6.3 Adding the Database Owner Role for Microsoft SQL Server
You need to add the CES administrative account to the database owner role for Microsoft SQL Server when you
want to install the Coveo SharePoint web service (see "Installing the Coveo Web Service, Search Box, and Search
Interface into SharePoint" on page 29).

The procedure applies to Microsoft SQL Server 2008, 2005, and 2000, but varies depending on the SQL Server
version:

l "Microsoft SQL Server 2008/2005" on page 39

l "Microsoft SQL Server 2000" on page 41

6.3.1Microsoft SQLServer 2008/2005

1. Access SQL Server Management Studio (Windows Start menu > All Programs > Microsoft SQL Server
2008 or Microsoft SQL Server 2005).

2. Connect to the appropriate database.
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3. In the panel on the left, expand localhost > Security > Logins.

4. When the login for the CES administrative account already exists, double-click it. Otherwise, right-click Logins,
and then click New Login.

5. In the Login - New dialog box:

a. In the Login Name box, type the CES administrative account.

b. In the panel on the left, click User Mapping.

c. In the panel on the right:

i. In the Users mapped to this login list, in the Map column, select the check box for the database to
which you want to assign the owner role to the CES administrative account.

ii. In the Database role membership for list, select db_owner.

d. Click OK.
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6.3.2Microsoft SQLServer 2000

1. Access SQL Server Enterprise Manager (Windows Start menu > All Programs > Microsoft SQL Server).

2. In the panel on the left, expand Microsoft SQL Servers > SQL Server Group > [your server group] > Security.

3. Click the Logins node.

4. When the login for the CES administrative account already exists, double-click it. Otherwise, right-click Logins,
and then click New Login.

5. In the SQL Server Login Properties - New Login dialog box: 

a. In the Login Name box, type the CES administrative account.

b. Click the Database Access tab.

c. In the list at the top, in the Permit column, select the check box for the database to which you want to
assign the owner role for the CES administrative account.

d. In the Permit in Database Role list, select db_owner.

e. Click OK.
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6.4 Coveo .NET Front-End First Time Setup
When you install the Coveo .NET Front-End components for the first time on a server, the installer automatically
accesses the search page at the end of the installation process. The Front-End Server Configuration web page
appears to allow you to complete the Front-End first time setup.

As a Coveo administrator, you can also access the Front-End Server Configuration page again later from the .NET
search interface Domore menu.

Notes:

l In some cases, such as with Claims authentication, the Domore menu Configure Front-End item does not
appear even when you are an administrator. In such a case, you can access the Front-End Server
Configuration page directly using the page URL in the form: 

http://[MyCoveoFrontEndServer]:8080/Coveo/FirstTimeSetup/default.aspx

or when the search page is integrated in SharePoint: 

http://[MySharePointServer]/_layouts/Coveo/FirstTimeSetup/

l The URL used to access the Front-End Server Configuration page is also used to automatically set the pre-
loading URL on the Back-End server. The pre-loading URL is used to warm up the Front-End search page,
eliminating longer loading time for end-users.

When the Front-End and Back-End components are installed on separate servers, if you can, use a search
URL that the Back-End server can resolve to access the Front-End Server Configuration page and correctly
set the pre-loading URL.

Example: Use http://MyCoveoSearchServer:8080 rather than http://localhost:8080.

Otherwise, a warning message appears (Back-End and Front-End components appear to be

installed on separate servers. You may need to change the default pre-loading search

page URL from the Administration Tool in the Configuration > Pre-loading page.) .

In the Front-End Server Configuration page, you must provide administrator credentials to configure the Back-End
server that this Front-End server uses to send queries and receive search results. You can also select or create the
search security certificate used to secure the connection between the Front-End and Back-End processes.

Coveo .NET Front-End 12.0.49+ (September 2012) CES 7.0.4855+ (August 2012) When the Coveo search
interface is installed on a server that uses Claims to authenticate users (such as a SharePoint server), you must
also provide Claims parameters.

To perform theCoveo .NET Front-End first time configuration

1. In the Front-End Server Configuration page, the Front-End Server Settings section appears only when the
current user does not have administrator permissions on the Front-End server.

Example: The Front-End Server Settings section appears when you access the Front-End Server
Configuration page from a Coveo .NET search interface installed on a SharePoint server that uses Claims to
authenticate users.
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a. In the Username and Password boxes, enter the credentials of an administrator account on the Front-End
server to be able to save the configuration performed in this page.

b. Click Login.

2. In the Coveo Enterprise Search Server Settings section that appears:

a. In the Connection Information section:

i. In the Hostname box, enter the hostname of the Coveo Master server, where Coveo Enterprise
Search (CES) is installed.

When the Coveo Front-End component is installed on the same server as the Coveo Master server,
you can use localhost. When they are on different servers, enter the hostname of the Master server,
even when you want to connect this Front-End server to a Mirror server (you will select the Mirror
server later in this page).

ii. In the case where your Coveo Master server uses a Coveo Search Web Service other than the default
(52810), expand the Advanced setting section, and in the Services Port, enter the appropriate value.
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Note: Do not confuse this port with the CES service port. The Front-End uses the Coveo Search Web
Service to get additional configuration information from the Back-End server, including the
CES service port (52800 by default) that the .NET search interface will use to communicate with the
server.

iii. Click Validate server information.

When the connection is established successfully, a green indicator ( ) appears next to the button.

When the connection cannot be completed, a red indicator and message ( Invalid server
information) appear next to the button and an error message appears at the top of the page. In this
case, adjust the connection information and try again.

b. In the Administrator Credentials section that appears:

i. In the Username and Password boxes, enter the credentials of a Coveo administrator account for the
Coveo Master (Back-End) server.

ii. In the Provider drop-down list, select the security provider that can validate these user credentials,
most likely Active Directory.

iii. Click Login.

3. Coveo .NET Front-End 12.0.1548+ (June 2016) When you want users of the search page you are configuring
to be able to see content from a SharePoint server configured with Claims authentication, the Coveo
.NET Front-End search page hosted outside SharePoint must authenticate each SharePoint end-user
performing queries.

In such a case, in the Claims SSO for SharePoint Settings section: 

a. Select the Import the claims SSO configuration from the SharePoint claims identity provider setup
page check box.
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b. In the Claims SSO Configuration to Import box, paste the claims SSO configuration that was generated in
the SharePoint claims identity provider setup page.

4. In the Mirror Settings section:

l When your Coveo implementation does not include Mirror servers:

Select the Select a mirror option, and in the drop-down box, leave Default.

l When your Coveo implementation includes one or more Mirror servers:

You can decide to which Mirror server this Front-End server sends queries.

Example:When you want to free the Master server from handling the queries, you can rather connect the
Front-End to a Mirror server.

Tip:When you have two or more Coveo Front-End servers, you can later set them up in a network load-
balancing cluster.

o Select the Select a mirror option, and in the drop-down box, select the mirror to which you want this
Front-End server to send the queries.

OR

a. When you configured your Mirror server to use a CES service port other than the default (52800),
select the Configure mirror manually option.

b. In the Mirror Hostname box, enter the Mirror hostname, otherwise, enter the same machine name as
in Hostname.

c. In the Mirror Port box, enter the port that your Mirror server uses.

5. When the Coveo .NET search page is installed on a server such as SharePoint that uses Claims to
authenticate users or when the Claims SSO for SharePoint is enabled, in the Claims-Based Authentication
Settings section that appears:
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a. Coveo .NET Front-End 12.0.1633+ (September 2016) In the Claims Security Provider drop-down lists,
select the claims security providers that you created for these Claims-based Front-End servers.

Note: Coveo .NET Front-End 12.0.1548– (June 2016) Only one Claims Security Provider is supported
for your Claims-based Front-End servers.

Example: You could index content from a Claims-based on-premises SharePoint server and also from
SharePoint Online. You need to create one Claims security provider for each of these SharePoint
instances.

Note: The following message appears when no Claims security provider is available:

A Claims Security Provider is required, add one with the Administration Tool.

b. In the Active Directory Security Provider drop-down list, select the Active Directory security provider to
use.

c. In the Claim type holding Active Directory users list, the first claim is automatically selected, typically in
the DOMAIN\username form, and is generally the best choice. Consider selecting another claim when the
first one does not work.
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Note: Coveo .NET Front-End 12.0.1459– (March 2016) With previous versions, the Claim type holding
Active Directory users list provided many more claims to select from.

l When you want end-users to be able to search for documents from other sources that were crawled
in an Active Directory environment, select the Claim Type to use to resolve an Active Directory
identity from a Claims identity. You must select a Claim Type that has a Claim Value Example in the
MyDomain\UserName or UserName@MyDomain.com form. Only the Claim Type is saved and used to
get the Claim Value for each user when they perform queries.

l When end-users can only search for Claims protected documents, you can select (None).

6. In the Search Certificate Settings section that appears:

a. For Select or create the search certificate to use to be trusted when communicating with the Back-
End server select one of the following options: 

Use the default certificate

The default certificate trusts everyone that has access to the .NET search interface and the Front-End
server can be any machine (any IP address).

Use an existing certificate

When you already created one or more search security certificates on the Back-End server, select the
desired certificate in the list that appears.
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Create a new certificate

Use this option to create a certificate to trust only specific users and/or groups and trust only servers
with specific IP addresses.

b. When you select Create a new certificate, use the parameters that appear to build the certificate:

i. In the Name box, enter a name for your new search security certificate.

ii. In the Trusted Users/Groups section, optionally define the trusted users:

A. Select Specific user and/or groups when you want this certificate to trust only specific users.

B. In the Name box, enter the name of a user or group to be trusted.

C. In the Type drop-down list, select if the name is for a user or group.

D. In the Provided drop-down list, select the security provider in which this user or group is defined.

E. Click Add.
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The specified user or group appears in the list.

F. When you want to add other trusted users or groups, repeat the previous steps.

iii. In the Trusted Front-End Servers section, define the IP address for one or more Front-End servers to
be trusted by the Back-End server:

A. Select Specific IP addresses when you want this certificate to trust only specific machines.

B. In the IP address box, enter an IP address to be trusted.

C. Click Add.

The specified IP address appears in the list.

D. When you want to add other trusted Front-End servers, repeat the previous steps.

7. In the Search Analytics Settings section, you can optionally configure this search front-end server to send
search usage information to an on-premises database and/or to the Coveo Usage Analytics cloud service to
later be able to review search usage data: 

Notes:

l Coveo .NET Front-End 12.0.1548+ (June 2016) .NET Framework 4.5 is required on the Coveo Front-End
server to push information to the Coveo Usage Analytics cloud service.

l CES 7.0.7711+ (June 2015) Support for sending analytics to the Coveo Usage Analytics cloud service.

a. When you have access to a deployed on-premises Coveo Analytics module, in the On-Premises
Analytics Module section:

i. Select the Enable check box.

ii. In the Database Connection String box, enter the connection string for the database of your Analytics
module.

iii. Click Test to validate the string.

b. Coveo .NET Front-End 12.0.1548+ (June 2016) When you have access to the Coveo Usage Analytics
cloud service, in the Cloud Platform section: 

i. Select the Enable check box.

ii. Depending on your setup, select one on the following radio button:

l In a non-NLB (Network Load Balancing) setup, select the Push usage analytics information
directly to the Coveo Usage Analytics cloud service radio button.

l In an NLB setup, select the Push usage analytics information directly to the Coveo Usage
Analytics cloud service radio button on one .NET Front-End server, and the Delegate pushing
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usage analytics information to another Coveo .NET Front-End NLB server radio button on the
other(s).

Notes:

o For high-volume environments, the best practice is to set up a separate .NET Front-End
server, outside the NLB, and whose only responsibility is to push events to the cloud
service.

o The URI of the Front-End(s) on which the Delegate pushing usage analytics information
to another Coveo .NET Front-End NLB server radio button is selected should point to the
Front-End that pushes the events to the cloud service.

iii. Depending on the radio button you select:

l When you select the Push usage analytics information directly to the Coveo Usage Analytics
cloud service radio button, in the API Key box, enter the API key to be used to call the Usage
Analytics REST endpoint, and then click Test to validate the endpoint.

Note: Contact Coveo Support to get an API key.

l When you select the Delegate pushing usage analytics information to another Coveo .NET
Front-End NLB server radio button, in the box, enter the URL of the Coveo .NET Front-End to
delegate pushing usage analytics information to in the following form:

http://[CoveoFrontEndServer]:8080/PushCloudAnalyticsInfo.aspx

8. Click Apply Settings.

9. Enable the Front-End that pushes UA information to the Coveo Usage Analytics cloud service to log errors in a
folder of your choice:

Note: Error logs are a good starting point when investigating problems.

a. Using a text editor, open the Web.config file (by default C:\Program Files\Coveo .NET Front-End

12\Web.config).

b. In the file, add the logFolder parameter (in red) in the analytics section as follows:

<analytics enabled="False" connectionString="Data Source=yourServerName;Initial

Catalog=CoveoAnalytics;Integrated Security=SSPI;" cloudEnabled="True" logFolder="D:\

[folderPath]" platformEndpoint=""

analyticsEndpoint="https://usageanalyticsdev.coveo.com/rest/v13" accessToken="YOURACCESSTOKEN"

analyticsCloudDelegateUri="http://YOURHOSTNAME:8080/PushCloudAnalyticsInfo.aspx"

analyticsCloudDelegateEnabled="False" />

The first time setup is completed and the default .NET search interface appears.
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What'sNext?

You can now customize or create search hubs and .NET search interfaces using the .NET Interface Editor.

4www.coveo.com 51

http://www.coveo.com/


Coveo Platform 7.0 | Microsoft SharePoint Legacy Connector Guide

7. Creating a Claims Security Provider for an On-Premises
SharePoint
CES 7.0.5031+ (March 2013)

When indexing content from a SharePoint Web Application using Claims-based authentication, the default in
SharePoint 2013, you must create a Claims security provider to allow authenticated users to search for documents
secured using Claims permissions. Without such a security provider, no results would be returned.

The role of the Claims security provider is to authenticate users in SharePoint and to retrieve the list of Claims
associated to each user. Knowing the Claims of a user, the Coveo index can return the search results this user is
entitled to see according to the permissions that were indexed on SharePoint documents.

In order to be authenticated by the Claims security provider, a user must log in to the Coveo search interface using
his SharePoint credentials. The Claims security provider can authenticate users in SharePoint using a Windows
identity or an identity provided by an Active Directory Federation Services (ADFS) server.

Notes:

l Coveo .NET Front-End version 12.0.99+ (March 2013 monthly release) is required to display search results
with Claims permissions.

l The SharePoint, SharePoint Legacy and OneDrive for Business (CES 7.0.8047+ (December 2015))
connectors can use the Claims for SharePoint On-premises security provider type.

l You can get familiar with how Coveo components deal with permissions on documents both at indexing and
query time.

To create aClaims security provider for an on-premisesSharePoint

1. On the Coveo server, access the Administration Tool.

2. In the Administration Tool, select Configuration > Security.

3. In the navigation panel on the left, select Security Providers.

4. In the Security Providers page, click Add.

5. In the Modify Security Provider…:
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a. In the Name box, enter a descriptive name of your choice for this security provider instance.

b. In the Security Provider Type drop down, select Claims for SharePoint On-premises.

c. In the User Identity drop-down list:

l In the case of an ADFS environment, when you select theWeb Application supports AD FS Claims
Authentication check box (see below) and a claims-aware Coveo Search is used (see "Configuring
the Claims-Aware Coveo Search Application" on page 101), select a user identity of any Windows
account that can be used to authenticate to ADFS.

l Otherwise, select the user identity that you created for the Microsoft SharePoint farm.

d. In the SharePoint Web Application Url box, enter the URL of the SharePoint Web Application using
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Claims-based authentication where the secured content to index is located.

e. In the Temporary path for the cache of User Claims box, you must enter the path where the temporary
cache of user Claims is saved.

f. Select theWeb Application supports NTLM Claims Authentication and/orWeb Application supports
AD FS Claims Authentication check boxes, according to the Claims authentication type that is enabled for
the SharePoint web application (see "Finding the Enabled Claims Authentication Type for a SharePoint
Web Application" on page 56).

Important:When using ADFS Claims Authentication, you need to make sure your ADFS environment
meets the requirement for the Claims security provider (see "ADFS Server Requirements for a Claims
Security Provider" on page 60).

Notes:

l The Claims security provider can simultaneously support more than one Claims authentication type
enabled for a Web Application.

l SelectWeb Application supports NTLM Claims Authentication for Windows authentication with
NTLM or Kerberos.

g. CES 7.0.5556+ (June 2013) The following parameters are required only when theWeb Application
supports AD FS Claims Authentication check box is selected:

i. In the Url of the SharePoint AD FS Server box, enter the URL of the ADFS server which is trusted by
SharePoint.

Note: If your SharePoint instance uses Okta as a single sign-on provider, leave this box empty (see
Okta Single Sign-On Provider for SharePoint On-Premises).

ii. In the Trust Identifier for SharePoint box, enter the Relying Party Trust identifier for the SharePoint
web application (see "Finding the Relying Party Trust Identifier for a SharePoint Web Application" on
page 61).

Note: If your SharePoint instance uses Okta as a single sign-on provider, leave this box empty (see
Okta Single Sign-On Provider for SharePoint On-Premises).

h. CES 7.0.5556+ (June 2013) The following parameters are required only when theWeb Application
supports AD FS Claims Authentication check box is selected and multiple ADFS servers are used to
authenticate users in SharePoint:

i. In the Url of the Identity Provider AD FS Server box, enter the URL of the ADFS server which is used
as an Identity Provider for the ADFS server trusted by SharePoint.

ii. In the Trust Identifier for the SharePoint AD FS Server box, enter the Relying Party Trust identifier
for the SharePoint ADFS server (see "Finding the Relying Party Trust Identifier for a SharePoint ADFS
server" on page 62).

i. CES 7.0.5785+ (August 2013) When theWeb Application supports AD FS Claims Authentication check
box is selected and a claims-aware Coveo Search is used (see "Configuring the Claims-Aware Coveo
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Search Application" on page 101), in the Bootstrap Token Signing Certificate (.cer) box, enter the path
on the Coveo Master server where you saved the certificate used by ADFS to sign requests from the
claims-aware Coveo search. If the requests are not signed by ADFS, leave this parameter empty. If the
requests are not signed by ADFS, leave this parameter empty.

j. In the Claim Type for User Names box, enter the type of Claim that should be used to uniquely identify
users. Leave the default value
(http://schemas.xmlsoap.org/ws/2005/05/identity/claims/nameidentifier) unless Coveo
Support recommends to change the value.

k. In the Claim Type(s) to Ignore box, enter the type(s) of Claims that should be ignored by the security
provider to prevent polluting the security cache with unnecessary claims.

Some of the Claims that are retrieved by the security provider when authenticating users in SharePoint can
safely be ignored. These are usually Claims that are reserved for internal use by SharePoint and that
cannot be used to set permissions on documents.

Example: SharePoint assigns to every user a Claim that identifies the last time the user was
authenticated. The value of this Claim is a timestamp, which has no value regarding document
permissions and cannot be selected in the SharePoint people picker.

l. CES 7.0.9167+ (December 2017) Select the Expand user's Granted Identities before first query check
box to evaluate users' granted identities before they perform their first query.

Note:When selected, results are returned following a user's first query. When cleared, results appears
only after the user performs a second query or after the user's granted identities are expanded.

m. In the Authentication Cookies Sliding Session Expiration Time (in days) box, enter the time interval, in
days, during which the Claims of a user authenticated by the Claims security provider remains valid.
Values smaller than one day are accepted (ex.: 0.5). The default is 1 day.

n. Next to Parameters, when instructed to do so by Coveo Support, click Add Parameter to add an hidden
parameter by entering the parameter Name and Value.

Note: CES 7.0.6830+ (July 2014) The parameter ClaimsMaximumSize is used to set the maximum
allowed size for a single Claims identity. The default value is 12288 (12 KB). A message similar to the
following one appears in the CES Console and logs typically when a user with claims exceeding this limit
logged in or performed a query: 

The security provider "Claims" has encountered an exception: class

CSP::SecurityException: The user 'user_name here' contains too much claims and

will be rejected.

When this condition occurs, the search results that are secured by Claims permissions are not returned
for the query.

o. Ensure that the Allow Complex Identities option is selected.

A Claims security provider may need additional parameters when you create identities. You can specify
these additional parameters only when the Allow Complex Identities option is selected.

p. Click Save or Apply Changes.
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What'sNext?

Create a SharePoint security provider that will use this Claims security provider.

7.1 Finding the Enabled Claims Authentication Type for a SharePoint Web
Application
You may need to identify the Claims authentication type that is enabled for a SharePoint Web Application when you
create a security provider.

To find the enabledClaims authentication type in a SharePoint 2013/2010WebApplication

1. Access SharePoint 2013/2010 Central Administration (Windows Start menu > All Programs > Microsoft
SharePoint 2013/2010 Products).

2. In SharePoint 2013/2010 Central Administration, under Application Management, selectManage web
applications.

3. Select the Web Application for which you want to find the Claims authentication type, and then click
Authentication Providers.

4. Click on the name of the Zone using Claims Based Authentication.

5. Scroll down to the Claims Authentication Types section.

7.2 Finding and Enabling the ADFS Service Endpoint URL Path
You may need to find and ensure that the Active Directory Federation Services (ADFS) service endpoint URL path
is enabled when you create a Claims security provider.

To find and enable the ADFS service endpoint URL path

1. Access AD FS 2.0 Management Console (Windows Start menu > All Programs > Administrative Tools >
AD FS 2.0 Management).

2. In AD FS 2.0 Management Console, under Services, select Endpoints.

3. Find the endpoint by looking at the Url Path column.

4. When the endpoint is disabled, right-click it, and then select Enable.
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8. Creating a Claims Security Provider for SharePoint Online
CES 7.0.5031+ (March 2013)

When indexing content from a SharePoint Online Web Application using Claims-based authentication, you must
create a Claims security provider to allow authenticated users to search for documents secured using Claims
permissions. Without such a security provider, no results would be returned.

The role of the Claims security provider is to authenticate users in SharePoint Online to retrieve the list of Claims
associated to each user. Knowing the Claims of a user, the Coveo Search can display the search results this user is
entitled to see according to the permissions that were indexed on SharePoint documents.

In order to be authenticated by the Claims security provider, a user must log in to the Coveo search interface using
his SharePoint Online credentials. The Claims security provider can authenticate users in SharePoint Online using
a native Office 365 identity or an identity provided by an ADFS server if Single Sign-On is enabled in SharePoint
Online.

Notes:

l Coveo .NET Front-End version 12.0.99+ (March 2013 monthly release) is required to display search results
with Claims permissions.

l The SharePoint, SharePoint Legacy and OneDrive for Business (CES 7.0.8047+ (December 2015))
connectors can use the Claims for SharePoint Online security provider type.

l You can get familiar with how Coveo components deal with permissions on documents both at indexing and
query time.

To create aClaims security provider for SharePoint Online

1. On the Coveo server, access the Administration Tool.

2. In the Administration Tool, select Configuration > Security.

3. In the navigation panel on the left, select Security Providers.

4. In the Security Providers page, click Add.

5. In the Modify Security Providers page:
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a. In the Name box, enter a descriptive name of your choice for this security provider instance.

b. In the Security Provider Type drop down, select Claims for SharePoint Online.

c. In the User Identity drop-down list:

l When a claims-aware Coveo Search is used (see "Configuring the Claims-Aware Coveo Search
Application" on page 101), select a user identity of any Windows account that can be used to
authenticate to ADFS.

l Otherwise, select the user identity that you created with an Office 365 account.

d. In the SharePoint Web Application Url box, enter the URL of the SharePoint Online Web Application
where the secured content to index is located.

e. In the Temporary path for the cache of User Claims box, you must enter the path where the temporary
cache of user Claims is saved.

f. In the Office 365 Native Users Domain(s) box, enter the domain name that was created with your Office
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365 account. The domain name to enter here must be the native domain created by Microsoft Online
Services, which is different from a private domain owned by your company (see "Finding Your Office 365
Native Domain Name" on page 61).

Note: You can enter more than one Office 365 domain, separating values by a comma.

g. Select the Single Sign-On (AD FS) is enabled check box when Active Directory synchronization is
activated in Office 365 and synchronized user accounts are used to log in to SharePoint Online.

Important:When using ADFS Claims Authentication, you need to make sure your ADFS environment
meets the requirement for the Claims security provider (see "ADFS Server Requirements for a Claims
Security Provider" on page 60).

CES 7.0.5556+ (June 2013) The following parameters are required only when the Single Sign-On (AD FS)
is enabled check box is selected:

i. In the Url of the SharePoint AD FS Server box, enter the URL of the ADFS server which is trusted by
SharePoint.

Example: https://adfs.mydomain.com

Note: CES 7.0.6684+ (May 2014) The SharePoint connector supports indexing SharePoint online
configured with Okta.

In this case, in the Url of the SharePoint AD FS Server box, enter the full path to your SharePoint
Online ActiveClientSignInUrl that should be in the form: 

https://acme.okta.com/app/office365/abcdefghGWUMNWLWYGXF/sso/wsfed/active

You can find your SharePoint Online ActiveClientSignInUrl in Okta, in the sign on instructions
of the Microsoft Office 365 application:

i. With an administrator account, log in into Okta.

ii. In the top menu, click Admin.

iii. In the administration panel, select Applications > Applications.

iv. In the Applications page, click Microsoft Office 365.

v. In the Microsoft Office 365 page, select the Sign On tab.

vi. In the Sign On tab, under Sign On Methods section, click View Setup Instructions.

vii. The ActiveClientSignInUrl is the value next to ActiveLogOnUri.

Ensure that you also set this ActiveClientSignInUrl for the SharePoint Security provider and the
SharePoint source.

ii. In the Trust Identifier for SharePoint box, enter the Relying Party Trust identifier for the SharePoint
web application (see "Finding the Relying Party Trust Identifier for a SharePoint Web Application" on
page 61).

h. CES 7.0.5556+ (June 2013) The following parameters are required only when multiple ADFS servers are
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used to authenticate users in SharePoint:

i. In the Url of the Identity Provider AD FS Server box, enter the URL of the ADFS server which is used
as an Identity Provider for the ADFS server trusted by SharePoint.

ii. In the Trust Identifier for the SharePoint AD FS Server box, enter the Relying Party Trust identifier
for the SharePoint ADFS server (see "Finding the Relying Party Trust Identifier for a SharePoint ADFS
server" on page 62).

i. When the Single Sign-On (AD FS) is enabled check box is selected and a claims-aware Coveo Search is
used (see "Configuring the Claims-Aware Coveo Search Application" on page 101), in the Bootstrap
Token Signing Certificate (.cer) box, enter the path on the Coveo Master server where you saved the
certificate used by ADFS to sign requests from the claims-aware Coveo search. If the requests are not
signed by ADFS, leave this parameter empty.

j. In the Authentication Cookies Sliding Session Expiration Time (in days) box, enter the time interval, in
days, during which the Claims of a user authenticated by the Claims security provider remains valid.
Values smaller than one day are accepted (ex.: 0.5).

k. Next to Parameters, when instructed to do so by Coveo Support, click Add Parameter to add an hidden
parameter by entering the parameter Name and Value.

Note: CES 7.0.6830+ (July 2014) The parameter ClaimsMaximumSize is used to set the maximum
allowed size for a single Claims identity. The default value is 12288 (12 KB). A message similar to the
following one appears in the CES Console and logs typically when a user with claims exceeding this limit
logged in or performed a query: 

The security provider "Claims" has encountered an exception: class

CSP::SecurityException: The user 'user_name here' contains too much claims and

will be rejected.

When this condition occurs, the search results that are secured by Claims permissions are not returned
for the query.

l. Ensure that the Allow Complex Identities option is selected.

A Claims security provider may need additional parameters when you create identities. You can specify
these additional parameters only when the Allow Complex Identities option is selected.

m. Click Save.

What'sNext?

Create an Office 365 security provider that will use this Claims security provider (see "Creating an Office 365
Security Provider for SharePoint Online" on page 73).

8.1 ADFS Server Requirements for a Claims Security Provider
SharePoint can use ADFS as a trusted identity provider. Your ADFS environment must meet the following
requirements to allow the Coveo Claims security provider to authenticate users in SharePoint.
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For single ADFS server environments

l SharePoint ADFS server endpoint

The following ADFS service endpoint must be enabled on your ADFS server (see "Finding and Enabling the
ADFS Service Endpoint URL Path" on page 56):

/adfs/services/trust/2005/usernamemixed

For multiple ADFS server environments

l SharePoint ADFS server endpoint

The following ADFS service endpoint must be enabled on the ADFS server which is trusted by SharePoint (see
"Finding and Enabling the ADFS Service Endpoint URL Path" on page 56):

/adfs/services/trust/2005/issuedtokenmixedsymmetricbasic256

l Identity Provider ADFS server endpoint

The following ADFS service endpoint must be enabled on the ADFS server which is trusted by SharePoint
ADFS server (see "Finding and Enabling the ADFS Service Endpoint URL Path" on page 56):

/adfs/services/trust/2005/usernamemixed

8.2 Finding Your Office 365 Native Domain Name
You may need to find the native domain name associated with your Office 365 account when you create a
SharePoint Online security provider.

To find the native domain name associatedwith your Office 365 account

1. Log on to the Microsoft Office 365 Online Portal using an administrative account.

2. Under Management, click on Domains.

3. The native domain should be listed with a name ending with .onmicrosoft.com.

8.3 Finding the Relying Party Trust Identifier for a SharePoint Web Application
You may need to find the Relying Party Trust identifier for your SharePoint Web Application when you create a
Claims security provider.

To find theRelying Party Trust identifier for your SharePointWebApplication

1. Access AD FS 2.0 Management Console (Windows Start menu > All Programs > Administrative Tools >
AD FS 2.0 Management).

2. In AD FS 2.0 Management Console, under Trust Relationships, select Relying Party Trusts.

3. In the Relying Party Trusts list:
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l For an on-premises SharePoint, find the line for SharePoint. The ADFS Relying Party Identifier will be the
value in the Identifier column.

l For SharePoint Online, the ADFS Relying Party Identifier is typically
urn:federation:MicrosoftOnline, but you can validate it as follows:

a. Right-click the Microsoft Office 365 Identity Platform line, and then select Properties.

b. In the Microsoft Office 365 Identity Platform Properties dialog box, select the Identifiers tab.

c. In the Relying party identifiers list, the ADFS Relying Party Identifier is the one starting with urn:,
such as urn:federation:MicrosoftOnline.

8.4 Finding the Relying Party Trust Identifier for a SharePoint ADFS server
You may need to find the Relying Party Trust identifier for your SharePoint ADFS server when you create a Claims
security provider.

Some federation environments use multiple ADFS servers to authenticate users in SharePoint. In these
environments, a trust is established between SharePoint and an ADFS server, and another trust between this ADFS
server and another ADFS server. Configurations using multiple ADFS servers can be used, for example, when
federating users from different Active Directory domains.
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In order for the Claims security provider to be able to authenticate to SharePoint web applications using such a
configuration, information from both ADFS servers is required.

To find theRelying Party Trust identifier for your SharePoint ADFS server

1. Log on to the ADFS server which is trusted by the SharePoint ADFS server.

2. Access AD FS 2.0 Management Console (Windows Start menu > All Programs > Administrative Tools >
AD FS 2.0 Management.

3. In AD FS 2.0 Management Console, under Trust Relationships, select Relying Party Trusts.

4. In the list of trusts displayed, find the trust for the ADFS server which is trusted by SharePoint. The ADFS
Relying Party Identifier will be the value in the Identifier column.
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9. Creating a Claims to Email Security Provider for
SharePoint Online
CES 7.0.7433+ (February 2015)

You can get SharePoint Online users (native and federated) and Office 365 groups expanded to email users. A
claims-based identity includes an email that the Claims to Email for SharePoint Online security provider extracts to
resolve the identity of the user.

This security provider is useful either when you want to convert a claims identity to an email identity, or when you
simply did not want to use a claims identity. The only requirement for the claims to email conversion to work is that
the email your users enter to log in to SharePoint Online must match the email they use when logging into your
Coveo search interface. The Claims to Email for SharePoint Online security provider was specifically designed for
cloud environments where the identity is neither Claims nor Active Directory.

Notes:

l The SharePoint, SharePoint Legacy, and OneDrive for Business (CES 7.0.8047+ (December 2015))
connectors can use the Claims to Email for SharePoint security provider type.

l You can get familiar with how Coveo components deal with permissions on documents both at indexing and
query time.

To create aClaims to Email security provider for SharePoint Online

1. On the Coveo server, access the Administration Tool.

2. In the Administration Tool, select Configuration > Security.

3. In the navigation panel on the left, select Security Providers.

4. In the Security Providers page, click Add.

5. In the Modify Security Providers page:
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a. In the Name box, enter a descriptive name of your choice for this security provider instance.

b. In the Security Provider Type drop down, select Claims to Email Security Provider for SharePoint
Online.

c. In the User Identity drop-down list, select the user identity that you created to crawl your SharePoint
Online.

d. In the Security Provider section:

i. In the drop-down list, select the provider that recognizes your users by their email addresses or active
directory accounts (see "Configuring an Email Security Provider" on page 66 or Configuring an Active
Directory Security Provider).

Notes:

l Blocked users (admin Office 365, active users, settings, sign-in status) are not expanded to
email users.

l The list of following SharePoint well-known claims are expanded to email users:

o c:0(.s|true (everyone)

o c:0-.f|rolemanager|spo-grid-all-users (everyone but external)

o c:0!.s|forms%3amembership [all federated (sync) and native (cloud) users]
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ii. When needed, click Add, Edit, or Manage security providers respectively to create, modify, or
manage email or active directory security providers.

e. In theWindows Azure Active Directory Module for Windows PowerShell box, ensure that the
MSOnline.psd1 file is available at the default location
(C:\Windows\System32\WindowsPowerShell\v1.0\Modules\MSOnline\MSOnline.psd1) on your
Coveo Master server following the installation of the Windows Azure AD Module installation (see
"Installing the Windows Azure AD Module for Windows PowerShell" on page 72). Change the path if
needed.

Notes:

l Windows PowerShell is used to retrieve Office 365 users and domains.

l The default value should be the right value, but make sure the referenced module is installed and is
located at this path.

f. Ensure that the Allow Complex Identities option is selected.

g. Click Save.

h. This security provider must be selected in the Security Provider for SharePoint Users parameter of the
SharePoint security provider set on your SharePoint or OneDrive for Business source.

What'sNext?

Create an Office 365 security provider that will use this Claims to Email security provider (see "Creating an Office
365 Security Provider for SharePoint Online" on page 73).

9.1 Configuring an Email Security Provider
An Email security provider is a simple email user identity container that can be used by another security provider to
recognize users by their email addresses. When used by more than one security providers attached to sources of
various types, an email security provider can act as a single sign-on system. An Email security provider does not
connect to any system so it does not need a user identity.

Note: You can get familiar with how Coveo components deal with permissions on documents both at indexing
and query time.

To configure anEmail security provider

1. On the Coveo server, access the Administration Tool.

2. On the menu, select Configuration > Security.

3. In the navigation panel on the left, select Security Providers.

4. In the Security - Security Providers page, click Add.

5. In the Modify Security Provider page:
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a. In the Name box, enter a name of your choice for your Email security provider.

b. In the Security Provider Type list, select Email.

Note: CES 7.0.5785 to 7.0.5935 (August to September 2013) The Email security provider DLL file is
missing in the CES distribution so you will not see the Email option in the Security Provider Type list.

To resolve this issue:

i. Contact Coveo Support to get a copy of the
Coveo.CES.CustomCrawlers.EmailSecurityProvider.dll file.

ii. When you receive the file, using an administrator account, connect to the Coveo Master server, and
then copy the file to the [CES_Path]\bin folder.

iii. When your Coveo instance includes a Mirror server, also copy the file to the [CES_Path]\bin folder
on the Coveo Mirror server.

iv. Restart the CES service so that the new DLL is recognized.

c. In the User Identity list, leave (none).

d. CES 7.0.7814+ (August 2015) (Optional) In the Security Provider list, select another security provider to
map Email identities to another identity type.
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Example: You want to map Email identities to Active Directory (AD) ones so you select an LDAP Lookup
security provider that is chained to an AD security provider. The LDAP Lookup security provider is then
able to find a user in AD from his email and extracts his User Principal Name (UPN), thus allowing a
mapping of the Email identity to an AD one. Contact Coveo Support for assistance on how to create an
LDAP Lookup security provider.

e. Leave the Allow Complex Identities option cleared as it does not apply to this type of security provider.

f. Click Apply Changes.

What'sNext?

Configure a security provider that will use this Email security provider.
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10. Creating anOffice 365 Security Provider for SharePoint
Online
CES 7.0.5031+ (March 2013)

Because Office 365 security groups can be used as domain groups in SharePoint Online to set documents
permissions, you must create an Office 365 security provider to allow authenticated users to search for documents
secured using SharePoint Online domain groups.

The role of the Office 365 security provider is to resolve Office 365 security groups into its list of members.

Notes:

l Coveo .NET Front-End 12.0.99+ (March 2013) Support to display search results with Claims permissions.

l The SharePoint, SharePoint Legacy, and OneDrive for Business (CES 7.0.8047+ (December 2015))
connectors can use the Claims for SharePoint On-premises security provider type.

l You can get familiar with how Coveo components deal with permissions on documents both at indexing and
query time.

To create anOffice 365 security provider for SharePoint Online

1. On the Coveo server, access the Administration Tool.

2. In the Administration Tool, select Configuration > Security.

3. In the navigation panel on the left, select Security Providers.

4. In the Security Providers page, click Add.

5. In the Modify Security Providers page:
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a. In the Name box, enter a descriptive name of your choice.

b. In the Security Provider Type drop down, selectOffice 365.

c. In the User Identity drop-down list, select the user identity that you created to crawl your SharePoint
Online.

d. In the Users Security Provider drop-down list, select the Claims Security Provider for SharePoint Online
or the Claims to Email Security Provider for SharePoint Online that you previously created (CES 7.0.7433+ (February
2015)) (see "Creating a Claims Security Provider for SharePoint Online" on page 57 and Creating a
Claims to Email Security Provider for SharePoint Online).

e. In theWindows Azure Active Directory Module for Windows PowerShell box, ensure that the
MSOnline.psd1 file is available at the default location
(C:\Windows\System32\WindowsPowerShell\v1.0\Modules\MSOnline\MSOnline.psd1) on your
Coveo Master server following the installation of the Windows Azure AD Module installation (see
"Installing the Windows Azure AD Module for Windows PowerShell" on page 72). Change the path if
needed.

Note: You need to install the Windows Azure AD Module version with the same word size (32-bit vs 64-
bit) as your version of CES. If you install the 64-bit version of the Windows Azure AD Module and run the
32-bit version of CES, when the connector requires the module, Windows will silently attempt to load the
32-bit version of the AD module, even if you specified the path for the 64-bit version.

f. Leave the Allow Complex Identities option cleared as it does not apply to this type of security provider.

g. Click Save.
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What'sNext?

Create a SharePoint security provider that will use this Claims security provider.
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11. Installing theWindows Azure ADModule for Windows
PowerShell
The Windows Azure Active Directory Module for Windows PowerShell cmdlets can be used to accomplish many
Windows Azure AD tenant-based administrative tasks such as user management, domain management and for
configuring single sign-on (see Manage Azure AD using Windows PowerShell).

The Coveo Office 365 security provider needed by the SharePoint connector when indexing SharePoint Online
content uses the Get-MsolGroupMember cmdlet to list users and groups that are members of a specific Office 365
security group (see Get-MsolGroupMember). In this case, you must install theWindows Azure Active Directory
Module on your Coveo Master server.

To install theWindowsAzure ADModule forWindowsPowerShell

1. Using an administrator account, connect to the Coveo Master server.

2. Referring to the Microsoft documentation:

a. Ensure that your Coveo Master server meets the following Windows Azure AD Module for Windows
PowerShell requirements:

l Windows 7, Windows 8, Windows Server 2008 R2, or Windows Server 2012.

l Microsoft .NET Framework 3.51 feature.

b. Download and install the appropriate Microsoft Online Services Sign-In Assistant version for your
operating system (see Microsoft Online Services Sign-In Assistant for IT Professionals RTW).

3. Install theWindows Azure Active Directory Module for Windows PowerShell (see Install the Windows Azure
AD Module).

4. Connect to Windows Azure AD by running the PowerShell command import-module MSOnline (see
Connect to Windows Azure AD).

What'sNext?

When you configure the Office 365 security provider, ensure that the
C:\Windows\System32\WindowsPowerShell\v1.0\Modules\MSOnline\MSOnline.psd1 file is available on
the Coveo Master server and referenced in theWindows Azure Active Directory Module for Windows PowerShell
parameter (see Creating an Office 365 Security Provider for SharePoint Online).
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12. Creating anOffice 365 Security Provider for SharePoint
Online
CES 7.0.5031+ (March 2013)

Because Office 365 security groups can be used as domain groups in SharePoint Online to set documents
permissions, you must create an Office 365 security provider to allow authenticated users to search for documents
secured using SharePoint Online domain groups.

The role of the Office 365 security provider is to resolve Office 365 security groups into its list of members.

Notes:

l Coveo .NET Front-End 12.0.99+ (March 2013) Support to display search results with Claims permissions.

l The SharePoint, SharePoint Legacy, and OneDrive for Business (CES 7.0.8047+ (December 2015))
connectors can use the Claims for SharePoint On-premises security provider type.

l You can get familiar with how Coveo components deal with permissions on documents both at indexing and
query time.

To create anOffice 365 security provider for SharePoint Online

1. On the Coveo server, access the Administration Tool.

2. In the Administration Tool, select Configuration > Security.

3. In the navigation panel on the left, select Security Providers.

4. In the Security Providers page, click Add.

5. In the Modify Security Providers page:

4www.coveo.com 73

http://www.coveo.com/


Coveo Platform 7.0 | Microsoft SharePoint Legacy Connector Guide

a. In the Name box, enter a descriptive name of your choice.

b. In the Security Provider Type drop down, selectOffice 365.

c. In the User Identity drop-down list, select the user identity that you created to crawl your SharePoint
Online.

d. In the Users Security Provider drop-down list, select the Claims Security Provider for SharePoint Online
or the Claims to Email Security Provider for SharePoint Online that you previously created (CES 7.0.7433+ (February
2015)) (see "Creating a Claims Security Provider for SharePoint Online" on page 57 and Creating a
Claims to Email Security Provider for SharePoint Online).

e. In theWindows Azure Active Directory Module for Windows PowerShell box, ensure that the
MSOnline.psd1 file is available at the default location
(C:\Windows\System32\WindowsPowerShell\v1.0\Modules\MSOnline\MSOnline.psd1) on your
Coveo Master server following the installation of the Windows Azure AD Module installation (see
"Installing the Windows Azure AD Module for Windows PowerShell" on page 72). Change the path if
needed.

Note: You need to install the Windows Azure AD Module version with the same word size (32-bit vs 64-
bit) as your version of CES. If you install the 64-bit version of the Windows Azure AD Module and run the
32-bit version of CES, when the connector requires the module, Windows will silently attempt to load the
32-bit version of the AD module, even if you specified the path for the 64-bit version.

f. Leave the Allow Complex Identities option cleared as it does not apply to this type of security provider.

g. Click Save.
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What'sNext?

Create a SharePoint security provider that will use this Claims security provider.
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13. Creating a Security Provider for the SharePoint Legacy
Connector
Deprecated

A SharePoint source created with the SharePoint Legacy connector needs a SharePoint security provider to
resolve permissions found on documents in the unified indexed. These permissions can either be SharePoint
groups, users, or domain groups. Of these three types of permissions, only SharePoint groups are actually
processed by the SharePoint security provider. Users and domain groups are simply forwarded to other security
providers for processing.

The other types of security providers required to process users and domain groups vary according to the
SharePoint environment being indexed, more precisely, according to the type of authentication provider (Classic
Windows, Claims-Based) used by the Web Application, and the SharePoint server version (2013/2010/2007 on-
premises and Online).

For this reason, before going on with the configuration of the SharePoint security provider, if not already done, you
must identify the type of your SharePoint environment from which you will be indexing content (see "Identifying Your
SharePoint Environment" on page 8).

Notes:

l CES 7.0.6830+ (July 2014) It is recommended to rather use the second generation SharePoint connector to
create your source. If you do so, ensure to use the corresponding SharePoint security provider type.

l You can get familiar with how Coveo components deal with permissions on documents both at indexing and
query time.

Tomodify or configure aSharePoint security provider

1. On the Coveo server, access the Administration Tool.

2. Select Configuration > Security.

3. In the Security page, in the navigation panel on the left, click Security Providers.

4. In the Security Providers page, click Add.

5. In the Modify Security Provider page:
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a. In the Name box, enter a name to identify this security provider.

Example: SharePoint Security Provider (Classic)

b. In the Security Provider Type drop-down list, select SharePoint Legacy (x64) (or SharePoint (x86) on a
32-bit Coveo server).
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Notes:

l CES 7.0.6830+ (July 2014) The SharePoint (x64) type corresponds to the security provider to be
used with the second generation SharePoint connector.

l CES 7.0.6767– (June 2014) The SharePoint Legacy (x64) security provider type was named
SharePoint (x64).

c. In the User Identity section:

i. In the drop-down list, select the user identity that you selected or created previously for this connector
(see "Type of User to Specify for the User Identity" on page 9).

ii. When needed, click Add, Edit, or Manage user identities respectively to create, modify, or manage
user identities.

Note: The User Identity specified here will be relevant later on in this topic when selecting the value of
the Authentication Type parameter.

d. In the Temporary path box, enter the path for the temporary security provider working folder on the Coveo
server. If not specified, a temporary working folder will be created by the security provider.

Example: C:\temp

e. In the SharePoint Server Url box, enter the following value according to your SharePoint environment:

l Classic and Online: leave blank.

l Claims: URL of the SharePoint Web Application where the Coveo SharePoint Web Service is
installed (see "Installing the Coveo Web Service, Search Box, and Search Interface into SharePoint"
on page 29).

f. In the Active Directory Security Provider drop-down list, for all SharePoint environments, select the
Active Directory security provider.

g. CES 7.0.5031+ (March 2013) In the Security Provider for SharePoint Users drop-down list, select the
following Security Provider according to your SharePoint environment.

l Classic: Select the Active Directory security provider.

l Claims: Select your Claims security provider for an on-premises SharePoint (see "Creating a Claims
Security Provider for an On-Premises SharePoint" on page 52).

l Online:

o Select your Claims security provider for SharePoint Online (see "Creating a Claims Security
Provider for SharePoint Online" on page 57).

OR
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o CES 7.0.7433+ (February 2015) Select your Claims to Email security provider for SharePoint
Online (see "Creating a Claims to Email Security Provider for SharePoint Online" on page 64).

h. CES 7.0.5031+ (March 2013) In the Security Provider for Domain Groups drop-down list, select the
following Security Provider according to your SharePoint environment.

l Classic: Select the Active Directory security provider.

l Claims: Select your Claims security provider for an on-premises SharePoint (see "Creating a Claims
Security Provider for an On-Premises SharePoint" on page 52).

l Online: Select your Office 365 security provider (see "Creating an Office 365 Security Provider for
SharePoint Online" on page 73).

i. In the Connection timeout box, consider changing the time interval the connector waits to establish the
connection with the SharePoint server. The default value is 30000 mS.

j. In the Timeout retry box, consider changing the number of times the connector retries to connect with the
SharePoint server before throwing an error. The default value is 3 retries.

k. In the Get changes timeout box, consider changing the time interval the connector waits to get changes
from the SharePoint server. The default value is 15000 mS.

l. CES 7.0.5031+ (March 2013) In the Authentication Type box, enter one of the following types of
authentication according to your SharePoint environment:

l Classic: Enter Default.

l Claims: If the User Identity specified on this security provider was:

o A Windows account, enter: WindowsUnderClaims

o Form authentication credentials, enter: FormsUnderClaims

o ADFS federated account, enter:  AdfsUnderClaims

l Online: If the User Identity specified on this security provider was:

o A native Office 365 user account (ex.: john@acme.onmicrosoft.com), enter:
OnlineUnderClaims

o A single sign-on Office 365 account (ex.: john@acme.com), enter: OnlineFederated

Note: The Authentication Type specified here is determined by the User Identity parameter that was
specified earlier in this topic.

m. CES 7.0.5556+ (June 2013) The following ADFS related parameters are only required when the
Authentication Type is either AdfsUnderClaims or OnlineFederated.

i. In the Url of the SharePoint AD FS Server box, enter the URL of the ADFS server which is trusted by
SharePoint.

ii. In the Trust Identifier for SharePoint box, enter the Relying Party Trust identifier for the SharePoint
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web application (see "Finding the Relying Party Trust Identifier for a SharePoint Web Application" on
page 61).

The following parameters are required only when multiple ADFS servers are used to authenticate users in
SharePoint:

i. In the Url of the Identity Provider AD FS Server box, enter the URL of the ADFS server which is used
as an Identity Provider for the ADFS server trusted by SharePoint.

ii. In the Trust Identifier for the SharePoint AD FS Server box, enter the Relying Party Trust identifier
for the SharePoint ADFS server (see "Finding the Relying Party Trust Identifier for a SharePoint ADFS
server" on page 62).

Note: At this point, the proper ADFS endpoint(s) should already have been enabled on the ADFS server
(s) during the configuration of the Claims for SharePoint 2010 Online security provider (see "ADFS
Server Requirements for a Claims Security Provider" on page 60).

n. Leave the Allow Complex Identities option cleared as it does not apply to this type of security provider.

o. In the Parameters section, in rare cases the Coveo Support could instruct you to click Add Parameters to
specify other security provider parameter names and values that could help to troubleshoot security
provider issues.

6. Click Apply Changes.

What'sNext?

Configure and index a Microsoft SharePoint source (see "Configuring and Indexing a Microsoft SharePoint Source
With the Legacy Connector" on page 81).
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14. Configuring and Indexing aMicrosoft SharePoint Source
With the Legacy Connector
Deprecated

A source defines a set of configuration parameters to extract and index Microsoft SharePoint content. This topic
describes how to create a source using the SharePoint Legacy connector.

Notes:

l In an environment with more than one Microsoft SharePoint Web Application, it is recommended to define
one source for each Microsoft SharePoint Web Application that you want to index, and only index user
profiles once to not create duplicates in your index.

l CES 7.0.6830+ (July 2014) The original SharePoint connector was renamed to SharePoint Legacy. The
SharePoint source type now corresponds to the second generation SharePoint connector that is
recommended to use.

To configure and index aMicrosoft SharePoint source

1. On the Coveo server, access the Administration Tool.

2. Select Index > Sources and Collections.

3. In the Collections section:

a. Select an existing collection in which you want to add the new source.

OR

b. Click Add to create a new collection.

4. In the Sources section, click Add.

The Add Source page that appears is organized in three sections.

5. In the General Settings section of the Add Source page:
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a. Enter the appropriate value for the following required parameters:

Name

Enter a descriptive name of your choice for the source.

Example: SharePoint Intranet

Source Type

CES 7.0.7814+ (August 2015) The connector used by this source. In this case, select SharePoint
(deprecated).

Notes:

l If you do not see SharePoint (deprecated) in the Source Type list, your environment does not
meet the requirements (see "Microsoft SharePoint Legacy Connector Requirements" on page 7).

l CES 7.0.7711– (June 2015) The SharePoint (deprecated) source type is named SharePoint
Legacy.

l CES 7.0.6767– (June 2014) The SharePoint Legacy source type is named SharePoint.

l CES 7.0.6830+ (July 2014) The SharePoint type corresponds to the source to be used with the
second generation SharePoint connector.

Addresses

List of specific SharePoint farm sections that you want to index. If you need to index more than one
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section, enter one URL per line.

Examples:

l For the whole farm: 

https://farm/

l For a specific Web Application: 

https://farm:8080/

l For a specific site collection: 

https://farm:8080/sites/Support/default.aspx

l For a specific website: 

https://farm:8080/sites/Support/subsite/default.aspx

l For a specific document library: 

https://farm:8080/Document Library/

l For a specific list:

https://farm:8080/sites/Support/Lists/Contacts/AllItems.aspx

Important: A specific folder in a list is not supported.

l For SharePoint Online: 

https://domain.sharepoint.com

Refresh Schedule

Time interval at which the index is automatically refreshed to keep the index content up-to-date. The
incremental refresh continuously takes care of indexing ongoing SharePoint content changes. You can
select to refresh the source weekly by selecting the Every Sunday option.

Note: You can create new or modify existing source refresh schedules.

b. Review the value for the following parameters that often do not need to be modified:

Rating

Change this value only when you want to globally change the rating associated with all items in this
source relative to the rating to other sources.

Example: If this source was for a legacy Intranet, you may want to set this parameter to Low, so that in
the search interface, results from this source appear later in the list compared to those from other
sources.

Document Types

If you defined custom document type sets, ensure to select the most appropriate for this source.
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Active Languages

If you defined custom active language sets, ensure to select the most appropriate for this source.

Fields

If you defined custom field sets, ensure to select the most appropriate for this source.

6. In the Specific Connector Parameters & Options section of the Add Source page, review if you need to
change the parameter default values:

a. In the SharePoint References drop-down list, select the appropriate SharePoint reference set for this
source.

Note: You can define custom SharePoint references.

b. In the Option section:

Index personal sites

Note: Personal websites are not available in Microsoft SharePoint Foundation.

When selected, indexes all the personal sites of the SharePoint farm (tenant in SharePoint Online).
This option is selected by default.

Index user profiles

When selected, indexes all the user profiles of the SharePoint farm (tenant in SharePoint Online). This
option is selected by default.
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Notes:

l Indexing user profiles can take a significant time depending on their number. Moreover, indexing
user profiles more than once, creates as many duplicates in your index. It is thus recommended
to only index your user profiles once for all your SharePoint sources:

o When you configure your first SharePoint source, let the check box selected. For all you
other SharePoint sources, clear the check box.

o When you already have other configured SharePoint source(s), look for your smallest Web
Application in size and clear the Index user profiles check box for all your other SharePoint
sources.

l User profiles are not available in Microsoft SharePoint Foundation.

Index subsites

When selected, indexes subsites recursively, starting with the URLs entered in the Addresses box,
and proceeding to deeper levels until every document has been indexed. This option is selected by
default.

Example:When http://intranet/pages/ is a URL entered in the Addresses box and Index
subsites is selected, the http://intranet/pages/news/ and
http://intranet/pages/news/2012/ websites are also indexed.

Index the document's metadata

When selected, CES indexes all the document metadata, even metadata that are not associated with a
field. The orphan metadata are added to the body of the document so that they can be searched using
free text queries.

When cleared (default), only the values of system and custom fields that have the Free Text Queries
attribute selected will be searchable without using a field query.

Example: A document has two metadata:

l LastEditedBy containing the value Hector Smith

l Department containing the value RH

In CES, the custom field CorpDepartment is bound to the metadata Department and its Free Text
Queries attribute is selected.

When the Index the document's metadata option is cleared, searching for RH returns the document
because a field is indexing this value. Searching for hector does not return the document because
no field is indexing this value.

When the Index the document's metadata option is selected, searching for hector also returns the
document because CES indexed orphan metadata.

Generate a cached HTML version of indexed documents

When you select this check box (recommended), at indexing time, CES creates HTML versions of
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indexed documents. In the search interfaces, users can then more rapidly review the content by
clicking the Quick View link rather than opening the original document with the original application.
Consider clearing this check box only if you do not want to use Quick View links.

Open results with cached version

Leave this check box cleared (recommended) so that in the search interfaces, the main search result
link opens the original document with the original application. Consider selecting this check box only
when you do not want users to be able to open the original document but only see the HTML version of
the document as a Quick View. In this case, you must also selectGenerate a cached HTML version of
indexed documents.

c. In the SharePoint Site Discovery section, specify which SharePoint site collections to index by selecting
one of the following options:

Index only starting addresses

Indexes only the sites (and subsites when the Index subsites option is selected) whose addresses are
entered in the Addresses box.

Index the starting addresses and all sites listed in the Portal Site Directory

Indexes the sites (and subsites when the Index subsites option is selected) whose URLs are entered
in the Addresses box as well as all sites, related to these addresses, listed in the portal site
directories.

Index the Web application of the starting addresses

Indexes all site collections of the Web Applications related to the starting addresses. The default
choice.

Index all the Web applications having the same host name

Indexes all site collections of all Web Applications related to the starting addresses, as long as the Web
Application has the same host as its related starting address.

Note: The Coveo SharePoint web service must be installed on the SharePoint farm (tenant in
SharePoint Online) otherwise, the connector is unable to locate all Web Applications (see "Installing
the Coveo Web Service, Search Box, and Search Interface into SharePoint" on page 29).

7. In the Security section of the Add Source page:
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a. In the SharePoint Security Provider drop-down list, you must select a security provider of type SharePoint
(see "Creating a Security Provider for the SharePoint Legacy Connector" on page 76).

b. In the Authentication drop-down list, select the user identity that you created for the Microsoft SharePoint
farm (tenant in SharePoint Online).

c. CES 7.0.5031+ (March 2013) In the Authentication Type section, select the type of authentication used to
access the SharePoint web services:

Windows (Classic)

Select for Web Applications that use classic authentication (NTLM or Kerberos), not Claims.

Forms (Claims)

Select for Claims-enabled Web Applications that use form authentication.

Windows (Claims)

Select for Claims-enabled Web Applications that use Windows authentication (NTLM or Kerberos).

AD FS (Claims) CES 7.0.5556+ (June 2013)

Select for Claims-enabled Web Applications that use ADFS as a trusted identity provider.

Office 365 (Native)

Select when crawling a SharePoint Online Web Application using a native Office 365 user account
(ex.: john@acme.onmicrosoft.com).
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Office 365 (Single sign-on)

Select when crawling a SharePoint Online Web Application using a single sign-on Office 365 user
account (ex.: john@acme.com).

d. CES 7.0.5556+ (June 2013) The following ADFS related parameters are only required when the
Authentication Type is either AD FS (Claims) or Office 365 (Single sign-on):

i. In the Url of the SharePoint AD FS Server box, enter the URL of the ADFS server which is trusted by
SharePoint.

ii. In the Trust Identifier for SharePoint box, enter the Relying Party Trust identifier for the SharePoint
web application (see "Finding the Relying Party Trust Identifier for a SharePoint Web Application" on
page 61).

The following parameters are required only when multiple ADFS servers are used to authenticate users in
SharePoint

i. In the Url of the Identity Provider AD FS Server box, enter the URL of the ADFS server which is used
as an Identity Provider for the ADFS server trusted by SharePoint.

ii. In the Trust Identifier for the SharePoint AD FS Server box, enter the Relying Party Trust identifier
for the SharePoint ADFS server (see "Finding the Relying Party Trust Identifier for a SharePoint ADFS
server" on page 62).

e. Click Save to save the source configuration and consider revising advanced source parameters before
starting indexing the new source (see "Modifying Hidden Microsoft SharePoint Source Parameters for the
Legacy Connector" on page 88).

OR

f. Click Save and Start to save and start indexing immediately.

Note:When your SharePoint Web Application uses Claims, the first time the SharePoint search interface is
accessed, the first time setup page appears with two panels to let you enter your Claims information and allow
access to the search interface (see "Coveo .NET Front-End First Time Setup" on page 42).

What'sNext?

Set an incremental refresh schedule for your source.

Consider modifying advanced source parameters (see "Modifying Hidden Microsoft SharePoint Source Parameters
for the Legacy Connector" on page 88).

14.1 Modifying Hidden Microsoft SharePoint Source Parameters for the Legacy
Connector
Deprecated

After you created a SharePoint source, you can modify a number of advanced parameters to fine-tune indexing of
your SharePoint content.

Note: You need to rebuild your source after changing advanced parameters.
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Tomodify SharePoint advanced source parameters

1. On the Coveo server, access the Administration Tool.

2. Select Index > Sources and Collections.

3. In the Collections section, select the collection containing the SharePoint source for which you want to change
advanced parameters.

4. In the Sources section, select the SharePoint source.

5. In the navigation panel on the left, select Advanced.

6. In the Advanced page:

a. In the Crawling section, select the desired crawling options:

Index hidden lists and their items

Specifies whether hidden lists should be indexed or not. SharePoint uses hidden (or internal) lists to
store non content information, such as Web Part galleries, work flow state, etc. These lists and their list
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items are not indexed by default.

Index redundant issue list items

Specifies whether redundant issues should be indexed or not. When an issue is updated in a
SharePoint issue list, SharePoint creates a new issue item, leaving the old one unchanged. These
redundant old issues are not indexed by default.

Index survey responses

Specifies whether survey responses should be indexed or not. When someone responds to a
SharePoint survey, this response is stored as a list item into the survey list. These responses are not
indexed by default.

Index documents uploaded with WebDAV

Specifies whether orphan documents should be indexed or not. Using the WebDAV functionality, it is
possible to store documents that do not belong to any SharePoint document libraries. These
documents are indexed by default.

Index social tags

Specifies whether social tags should be indexed or not. In SharePoint 2010, users can tag content to
categorize information in ways that are meaningful to them. Social tagging can improve the quality of
search results by filtering against specific tags. The social tags are not indexed by default. When
selected, this option slightly affects crawling performances.

Note: Only public social tags are indexed, not personal social tags.

Disable cookies

Specifies whether the connector should cache and reuse the cookies sent by the crawled site. The
cookies are enabled by default.

Expand sites and lists before applying filters

Specifies whether the connector should retrieve the SharePoint websites and list children before
applying the source filters. This option is required to index a specific part of a SharePoint website or
list. This option is disabled by default.

Note: Enabling this option slows down the connector as it retrieves all children of all websites and
lists from SharePoint and rejects filtered documents just before indexing them.

Example: When http://intranet/ is the main website, http://intranet/pages/* is the only
source inclusion filter, and Expand sites and lists before applying filters is selected,
http://intranet/pages/ and http://intranet/pages/news/ websites are indexed. When
Expand sites and lists before applying filters is not selected, nothing will be indexed as
http://intranet/ will be filtered out.

Use the author extracted from the document instead of the SharePoint author

A document stored in a SharePoint document library may have two different authors, the author of the
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document stored in the document properties and the author stored in the SharePoint database, which
represents the person who has modified or added the document into SharePoint. By default, CES uses
the SharePoint author instead of the document author. Select this option to modify this behavior.

Note: A side effect of selecting this option is that the CES SharePoint search interface cannot link the
search result author to the SharePoint user, as the document author may not be a SharePoint user.

Enable Microsoft Office integration

Specifies whether Microsoft Office documents should be opened directly within SharePoint (using
SharePoint ActiveX) when the user clicks a search result. When this option is not selected, the
document is opened outside SharePoint in the corresponding Microsoft Office application.

b. In theWebParts Content Indexing section, you can select among four options to determine how the
connector indexes the content of Web Parts:

Important: Selecting to index dynamically generated content such as Web Parts may expose secured
information as the crawler may see and index content that not all users have access to.

Note: Not all Web parts are available in Microsoft SharePoint Foundation 2010 (see Overview of Web
Parts available in SharePoint Foundation 2010).

Don't index the WebParts content

Ignores the content of the Web Part pages, including the content of the Web Parts.

Index the content of all WebParts

Indexes the content of all Web Parts in all the Web Part pages. This option is not supported for
SharePoint 2003.

Indexes the full WebPart page content, including menus

Indexes the complete Web Part pages as a web crawler would do. Because the full page is indexed,
including menus, controls, etc., this option can cause index pollution.

Index the content of the WebParts of these types only

Only indexes the content of Web Parts which assembly types are listed in the text box appearing when
the option is selected. The Microsoft.SharePoint.WebPartPages.ContentEditorWebPart type
appears by default in the text box. This option is selected by default but is not supported for SharePoint
2003.

Note: You can find the assembly types of the Web Parts that you want to index from the Site Settings
(see "Finding the Assembly Type of a SharePoint Web Part" on page 92).

c. In the Server Name Alias box, optionally enter a server name that, in the index, overrides the one from
which documents are downloaded in the index. This parameter is useful to have query results point to a
server other than the one used for indexing.
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Example: Three network load balanced (NLB) SharePoint front-end servers handle the end-users
requests and your source crawls a fourth mirror server to not impact performance for users. In the Server
Name Alias box, enter the NLB URL to replace the IP address in the index.

d. In the Priority drop-down list, select the download priority relative to other SharePoint sources.

e. In the Performance section, consider disabling features to improve the performance:

Disable advanced text layout analysis for PDF documents

For better content indexing, CES by default analyzes PDF documents to identify text columns and
restore appropriate content ordering. This process can be disabled to save CPU resources while
indexing.

Disable advanced duplicate document filtering

By default CES applies an advanced filter to display only one copy of each document in the search
results. Select this option to disable the filtering of duplicate documents in order to save CPU resources
and speed up indexing.

f. In the Conversion Timeout box, enter the number of minutes after which the converter proceeds to
another document even if the conversion is not complete. When the timeout occurs, the document for
which the conversion was aborted is considered corrupted. By default, the conversion timeout is 10
minutes.

g. Click Apply Changes.

7. Start indexing the source by clicking Start or Rebuild from the button bar at the top of the page.

8. Validate that the source building process is executed without errors:

l In the navigation panel on the left, click Status, and then validate that the indexing proceeds without
errors.

OR

l Open the CES Console to monitor the source building activities.

14.2 Finding the Assembly Type of a SharePoint Web Part
You may need to find the assembly type of Web Parts that you want to index when you select the Index the content
of the WebParts of these types only option for a SharePoint source).

Tip:When useful, you can also get SharePoint Web Part assembly name and type programmatically (see Get web
part assembly name and type name from SharePoint web part gallery).

To find the assembly type of a SharePointWebPart

1. Using a SharePoint administrator account, select the site collection containing the Web Part that you want to
index.

2. In the Site Actions menu, select Site Settings.

3. In the Site Settings page, under Galleries, clickWeb Parts.
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4. In the list of Web Parts that appears, click the Edit icon for the Web Part that you want to index.

The Web Part file can either have a .dwp or a .webpart extension

Example: Click the Edit icon for the MSContent Editor.dwp file corresponding to the default Web Part
assembly type.

5. Click View XML.

6. In the XML, copy the text between the <TypeName> and </TypeName> tags.

Example: In the following XML code, you would copy
Microsoft.SharePoint.WebPartPages.ContentEditorWebPart.

<?xml version="1.0" encoding="utf-8" ?>
<WebPart xmlns="http://schemas.microsoft.com/WebPart/v2">
<Assembly>Microsoft.SharePoint, Version=12.0.0.0, Culture=neutral,

PublicKeyToken=71e9bce111e9429c</Assembly>
<TypeName>Microsoft.SharePoint.WebPartPages.ContentEditorWebPart</TypeName>
<Title>Content Editor Web Part</Title>
<Description>Use for formatted text, tables, and images.</Description>
<PartImageLarge>/_layouts/images/mscontl.gif</PartImageLarge>

</WebPart>

14.3 SharePoint Source Refresh Troubleshooting for the Legacy Connector
Deprecated

This topic presents possible causes and solutions for error messages logged by full or incremental refreshes on a
Microsoft SharePoint source.

Unable to perform an incremental refresh of source [SourceName] from collection [CollectionName]. A full
refresh is required before an incremental refresh can be performed.

No change token was found for the current web application.

Possible causes:

l The source full refresh was stopped before the change token was persisted.

l The source full refresh was unable to persist the change token (see "Unable to persist the incremental
refresh token for source [SourceName] from collection [CollectionName]. Error:.. " on page 94).

l The client has changed the source starting addresses, thus the change token is no more valid.

Possible solution:

l Perform a full refresh of the source.

The last refresh of the source [SourceName] from collection [CollectionName] was not performed recently
(30 days ago). Consider performing a full refresh of the source.

The change token is very old, which has two possible consequences:
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l The SharePoint web services might refuse to send modified data because it may contain too much
information.

l The incremental refresh run might be very long, thus it may be more efficient to perform a simple full refresh.

Possible solution:

l Perform a full refresh of the source

Unable to persist the incremental refresh token for source [SourceName] from collection [CollectionName].
Error:..

An internal error is preventing the crawler to persist the change token, thus the incremental refresh run will not
be possible.

Possible solution:

l Contact Coveo Support for more information.
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15. Manually Configuring a .NET Search Interface Claims
SSO for anOn-Premises SharePoint
A Coveo .NET Front-End search interface that resides outside SharePoint must authenticate the SharePoint end-
user performing the query to return SharePoint search results for which the end-user has read access in
SharePoint. No SharePoint results are returned to unauthenticated users.

Note: Coveo .NET Front-End 12.0.1548+ (June 2016) The procedure described in this topic is no longer needed
with the new Coveo Front-end SSO Configuration page.

This topic describes how to configure both your SharePoint server and your Coveo .NET Front-End to provide a
single sign on (SSO) solution and automatically authenticate Claims end-users in a Coveo .NET search interface
that reside outside SharePoint.

You can provide this seamless experience to end-users searching for secured content indexed from Claims-
enabled SharePoint web applications using Windows authentication (NTLM) even when your SharePoint
environment does not use the Windows Identity Foundation (WIF).

How itWorks

The Coveo SSO solution uses browser redirections similar to what the Windows Identity Foundation (WIF) does to
authenticate users with Claims-aware web applications:

l A user accesses the Coveo .NET search interface with a browser.

l When the Coveo SharePoint Claims cookie is not available or expired, the Coveo search interface web app
redirects the browser to a Coveo deployed specific web page on the SharePoint server.

l This SharePoint web page uses NTLM or Kerberos so it can retrieve the full Claims identities of the user or
otherwise prompts the user to login to SharePoint.

l The SharePoint web page encrypts, packages, and sends the Claims back to the Coveo search interface web
app.

l The Coveo search interface web app receives the user Claims package, creates the cookie, and reloads the
Coveo search interface page.

l The user now has the full Claims identities to perform his queries.

l The round trip may or may not be noticeable depending on your environment.

HTTPS VersusHTTP

You can configure Claims SSO for both secure (HTTPS) and non-secure (HTTP) connections. When a Coveo
search page or a SharePoint web application can be accessed from outside a firewall (Internet), HTTPS is
recommended. When Coveo and SharePoint servers can be accessed only from client machines running behind
the same firewall, both HTTP and HTTPS are good options. The examples presented in this topic arbitrarily show
HTTPS connections.

4www.coveo.com 95

http://www.coveo.com/


Coveo Platform 7.0 | Microsoft SharePoint Legacy Connector Guide

When the claims authentication is enabled between a Coveo Front-End and a SharePoint web application, tokens
are exchanged between both servers. A token basically contains the user identity, but never contains passwords or
other sensitive information. The tokens are encoded, compressed, and signed, to prevent an eventual hacker from
altering and using them illegitimately.

Note: Coveo .NET Front-End 12.0.614 to 12.0.844 (February to June 2014) Claims SSO can be configured only
for secure (HTTPS) connections.

15.1 SharePoint Server Configuration

Note:When you have more than one SharePoint front-end server in your SharePoint farm, you must perform the
following procedure for each SharePoint front-end server.

1. Ensure that your environment meets the following requirements:

l SharePoint 2013/2010 (on-premises)

l SharePoint server web application configured in Windows Claims (NTLM or Kerberos)

l Coveo .NET Front-End 12.0.614+ (February 2014)

2. Using an administrator account, connect to the operating system of your SharePoint front-end server.

3. If not already done, deploy the Coveo integration in your SharePoint web application to ensure that at least the
SharePoint Web Service option is installed (see "Installing the Coveo Web Service, Search Box, and Search
Interface into SharePoint" on page 29).

4. On the first front-end server of your SharePoint farm, create two empty files that will be filled with the private and
public communication signing keys.

Note: The private and public keys are generated by the front-end server at the first use. You can easily
regenerate new keys simply by deleting the original key files and recreating these two empty files.

On other front-end servers of your SharePoint farm, rather paste a copy of these filled files (do not copy the
empty files) to ensure that all front-end servers use the same public and private key files.

Example: The files could be:

l C:\Program Files\Coveo .NET Front-End

12\Web\ClaimsAuthenticationKeys\ClaimsAuthenticationPublicKey.bin

l C:\Program Files\Coveo .NET Front-End

12\Web\ClaimsAuthenticationKeys\ClaimsAuthenticationPrivateKey.bin

Important: Protect your private key file once it is created. This file should never be shared nor sent via email.
Anyone that can access this key could use it to create his own Claims and be able to gain access to all
SharePoint documents from CES.

5. Right-click the key file folder and then use its Properties to ensure that the application pool identity running the
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web application where Coveo is integrated has read and write access to the key files.

6. Using a text editor: 

a. Open the web.config file of the SharePoint web application site.

Example: The file is typically: 

C:\inetpub\wwwroot\wss\VirtualDirectories\12345\web.config

b. Under coveoEnterpriseSearch, if not already present, add a claimsAuthentication section, ensure
it includes the following attributes, and then update the attributes values according to your setup: 

l identityReceiverUrl="https://YourCoveoFrontEnd/ClaimsIdentityReceiver.aspx"

l identityProviderPrivateKeyPath="PathToPrivateKey"

l identityProviderPublicKeyPath="PathToPublicKey"

Example: The claimsAuthentication section looks like: 

<claimsAuthentication
identityReceiverUrl="https://YourCoveoFrontEnd/ClaimsIdentityReceiver.aspx"
identityProviderPrivateKeyPath="C:\Program Files\Coveo .NET Front-End
12\Web\ClaimsAuthenticationKeys\ClaimsAuthenticationPrivateKey.bin"
identityProviderPublicKeyPath="C:\Program Files\Coveo .NET Front-End
12\Web\ClaimsAuthenticationKeys\ClaimsAuthenticationPublicKey.bin" />

c. Coveo .NET Front-End 12.0.1459+ (March 2016) When the search page is accessed via a Network Load
Balancing (NLB) IP address, just before </coveoEnterpriseSearch>, you may have to add the
assumedHttpRequestUrlScheme option in the following format:

<options assumedHttpRequestUriScheme="value" />

replacing value by either http or https.

Important: If missing, you must add the following element before the closing sectionGroup tag
(</sectionGroup>) for the assumedHttpRequestUrlScheme option to be supported:

<section name="options" type="System.Configuration.SingleTagSectionHandler,
System, Version=1.0.3300.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" />

Notes:

l When the option is present, the .NET UI assumes that the search page is always opened using the
specified scheme. Otherwise, the .NET UI assumes IIS detects the right scheme.

l You may also have to add the option in the Coveo .NET Front-End web.config file (see Coveo
.NET Front-End Server Configuration).

l You can use this option when troubleshooting the
Coveo.CES.Web.Search.Security.ClaimsIdentityException: Attempt to retrieve a

token in HTTP without supplying the main identity. error.
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Example: Your IIS site is configured to switch automatically in HTTPS if a browser tries to open the
search page in HTTP, so you add (<options assumedHttpRequestUriScheme="https" />).

d. If more than one standalone Coveo Front-End server use this SharePoint web application as their identity
provider or if the standalone Coveo front-end server can be reached from multiple URLs, in the
<identityReceivers> subsection, configure each one to allow them to retrieve the cookie.

Example:

<claimsAuthentication
identityReceiverUrl="https://DefaultCoveoFrontEnd/ClaimsIdentityReceiver.aspx"
identityProviderPrivateKeyPath="PathToPrivateKey"
identityProviderPublicKeyPath="PathToPublicKey">
<identityReceivers>
<add domain="CoveoFrontEnd1" url="https://CoveoFrontEnd1/ClaimsIdentityReceiver.aspx" />
<add domain="CoveoFrontEnd1DifferentUrl"

url="https://CoveoFrontEnd1DifferentUrl/ClaimsIdentityReceiver.aspx" />
<add domain="CoveoFrontEnd2" url="https://CoveoFrontEnd2/ClaimsIdentityReceiver.aspx" />

</identityReceivers>
</claimsAuthentication>

Notes:

l Coveo .NET Front-End 12.0.777+ (May 2014) The <identityProviders> subsection is supported.

l You should also leave a working identity receiver URL in the <claimsAuthentication> section
that will be used when the user comes from another domain.

e. Save the file.

7. Using a browser, access to the URL of the following form to test your setup:

https://YourSharePointSite/_layouts/CES/ClaimsIdentityProvider.aspx?debug=1

You should see a web page that contains various claims information. You should not see errors. The private
and public key files should now be filled with the new key data.

8. At this point, if you want, you can remove the write access of the web application pool identity to the key files
path.

15.2 Coveo .NET Front-End Server Configuration

Note:When you have more than one Coveo Front-End server in your Coveo deployment, you must perform the
following procedure for each Coveo Front-End server.

1. Using an administrator account, connect to the operating system of your Coveo .NET Front-End server.

2. Copy the public key file created on your SharePoint front-end server and paste it to the Coveo Front-End
server.
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Example: On the Coveo .NET Front-End server, you can copy the file to: 

C:\Program Files\Coveo .NET Front-End

12\Web\ClaimsAuthenticationKeys\ClaimsAuthenticationPublicKey.bin

Note: The public key file does not have to be secured like the private key file. It can safely be shared on a file
share or sent by email.

3. Using a text editor: 

a. Open the Coveo .NET Front-End web.config file.

Example: The file is typically: 

C:\Program Files\Coveo .NET Front-End 12\Web\Web.config

b. Under coveoEnterpriseSearch, if not already present, add a claimsAuthentication section, and
ensure it includes the following attributes, and then update the attributes values according to your setup: 

l identityProviderUrl="https://YourSharePointSite/_

layouts/CES/ClaimsIdentityProvider.aspx"

l identityValidatorPublicKeyPath="PathToPublicKey"

Example: The claimsAuthentication section looks like: 

<claimsAuthentication identityProviderUrl="https://YourSharePointSite/_
layouts/CES/ClaimsIdentityProvider.aspx" identityValidatorPublicKeyPath="C:\Program
Files\Coveo .NET Front-End 12\Web\ClaimsAuthenticationKeys\ClaimsAuthenticationPublicKey.bin"
/>

c. Coveo .NET Front-End 12.0.1459+ (March 2016) When you add the assumedHttpRequestUrlScheme
option in the web.config file of the SharePoint web application site, just before
</coveoEnterpriseSearch>, specified the same option and value.

Example: Your IIS site is configured to switch automatically in HTTPS if a browser tries to open the
search page in HTTP, so you add (<options assumedHttpRequestUriScheme="https" />).

d. If not already present, as shown in the following file sample, add the Coveo.CES.Web.Search.Security
namespace.

<configuration>
<system.web>
<pages>
<namespaces>
...
<add namespace="Coveo.CES.Web.Search.Security" />
...

</namespaces>
</pages>

</system.web>
</configuration>
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Note: CES 7.0.6339– (January 2014) You need at least two CES upgrades subsequent to the
CES 7.0.6424 (February 2014 monthly release) or a fresh install of the Coveo .NET Front-End to see the
Coveo.CES.Web.Search.Security namespace.

e. Save the file.

4. Using a browser, access your Coveo .NET search interface using the real hostname of the server, not
localhost.

Example: The Coveo .NET search interface page URL is typically:

https://YourCoveoFrontEndServer/

The first time you access the .NET search interface with a given browser, a security cookie is created (see "How
it Works" on page 95).

Note:When your SharePoint server is configured to prompt the users for a password, the user will have to
enter its SharePoint password in the process.

5. Perform the first-time setup to configure the Coveo .NET Front-End (see "Coveo .NET Front-End First Time
Setup" on page 42).

6. In the Coveo .NET search interface, verify that you have access to all your secured SharePoint documents.
When the scope of the .NET search interface includes non-SharePoint content, also verify that you have access
to this content.
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16. Configuring the Claims-Aware Coveo Search Application
This topic describes how to set up a Coveo search application to allow a seamless experience for Coveo end-users
searching for secured content indexed from Claims-Enabled SharePoint web applications. A Claims-aware Coveo
search application allows Claims-authenticated users to not have to log in to the Coveo .NET search interface
outside of SharePoint to see search results matching their Claims.

Note: A better SSO solution that works with or without ADFS is now available (see "Manually Configuring a .NET
Search Interface Claims SSO for an On-Premises SharePoint" on page 95).

Requirements:

l SharePoint web applications must be using ADFS 2.0 as a Trusted Identity Provider.

l Configuration will be required on the ADFS server used by SharePoint in order for Coveo search users to be
authenticated by ADFS.

l The Coveo SharePoint web service must be installed on your SharePoint server (see "Installing the Coveo
Web Service, Search Box, and Search Interface into SharePoint" on page 29).

Limitation:

l Claims-Based SharePoint web applications using Windows authentication (NTLM or Kerberos) will still require
users to enter their Windows credentials in the Coveo Search prior to the initial search.

The procedure consists of the following steps:

l "Step 1: Enabling Claims Authentication on the Coveo Search Site" on page 101

l "Step 2: Creating the Coveo Relying Party Trust" on page 103

l "Step 3: Editing Claims Rules for the Coveo Relying Party Trust" on page 103

l "Step 4: Editing Claims Rules for the SharePoint Relying Party Trust" on page 104

l "Step 5: Configuring the Coveo Service Account for ADFS Identity Delegation" on page 104

l "Step 6: Performing the First-Time Setup on the Coveo Search Site" on page 105

16.1 Step 1: Enabling Claims Authentication on the Coveo Search Site
Enabling Claims authentication on a search site consists mainly in modifying the web.config file of the search
website using the FedUtil.exe tool that comes with the Windows Identity Foundation (WIF) SDK.

1. Using an administrator account, login to the Coveo Front-End server.

2. In IIS, add an HTTPS binding to Coveo .NET Front-End web site.

3. Download and install the WIF SDK for Microsoft .NET Framework 3.5 (see Windows Identity Foundation SDK).
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Note:WIF is included in Microsoft .NET Framework 4.5, but currently, Coveo assemblies rely on the Microsoft
.NET Framework 3.5.

4. Start FedUtil.exe that is typical in C:\Program Files (x86)\Windows Identity Foundation

SDK\v3.5\.

Note: For the details on the FedUtil.exe tool refer to the Microsoft documentation (see Establishing Trust
from an ASP.NET Relying Party Application to an STS using FedUtil).

a. In the first screen, specify the path to the web.config file (by default: C:\Program Files\Coveo .NET

Front-End 12\Web\) and the URL to the search page with a slash at the end (ex.:
https://machinename/).

b. In the second screen:

i. Select the Use an existing STS option and then specify the URL of the federation metadata document
(ex.: https://adfs01.mycompany.com/FederationMetadata/2007-
06/FederationMetadata.xml).

ii. Click Test location to validate that the URL is valid.

c. In the third screen, select the option that corresponds to whether certificate chain validation should be
enabled or not.

d. In the next screen, select the option that corresponds to whether security tokens should be encrypted or
not.

e. In the next screen (claim list), click Next.

f. In the final screen, click Finish.

Note: The important file to configure the trust relationship in ADFS is: [coveo_web_site_
folder]\FederationMetadata\2007-06\FederationMedatada.xml

5. In Internet Information Services (IIS) Manager:

a. Ensure that theWindows Authentication is enabled on the search site by clicking the site in the tree view
to the left, and then > IIS > Authentication.

You may need to disable all the other authentication methods for Claims authentication to work.

b. For Claims authentication to work, the application pool pipeline mode must be Integrated (not Classic).
Ensure that the website is using an application pool that is configured correctly. Either modify the
application pool (if only the Coveo search site is using it) or create a new application pool and make the
website using it:

i. Click the site in the tree view to the left > Basic Settings.

ii. Click Application Pools almost at the top of the tree view to the left > click on the application pool in
the list > Basic Settings.
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Important: In IIS, the searchAdmin site under Coveo .NET Front-End 12 corresponds to the .NET search
interface and by default shares the CESAppPool Front-End application pool with the Coveo .NET Front-
End 12 site (the search page). The application pool pipeline mode must stay to Classic for the searchAdmin
site (the .NET search interface) to work, otherwise a user will get the following message when trying to access
the .NET search interface: 

Server Error in Application "COVEO .NET FRONT-END 12/SEARCHADMIN"

HTTP Error 500.24 - Internal Server Error

An ASP.NET setting has been detected that does not apply in Integrated managed

pipeline mode.

The solution is to create another application pool, assign it to the searchAdmin site, and ensure the
application pool pipeline mode is set to Classic.

6. Using a text editor:

a. Open the web.config file.

b. Under <microsoft.identityModel>, locate the <service> tag.

c. Add the "saveBootstrapTokens" attribute as follows:

<microsoft.identityModel>
<service saveBootstrapTokens="true">

16.2 Step 2: Creating the Coveo Relying Party Trust
1. Login to the ADFS server which is used as an Identity Provider by SharePoint, hereafter called the Identity

Provider ADFS server.

2. Launch AD FS 2.0 Management Console.

3. Select AD FS 2.0 > Trust Relationships.

4. Right-click Relying Party Trusts and then select Add Relying Party Trust.

5. In the new window, select the Import data about the relying party from a file option.

6. Select the FederationMetadata.xml file that was previously obtained in Step 1, and then click Next.

7. Enter a Display Name such as Coveo Claims-Aware Search Site, and then click Next.

8. Select Permit all users to access this relying party, and then click Next.

9. Validate settings on the final page and then click Next to create the new Relying Party Trust.

16.3 Step 3: Editing Claims Rules for the Coveo Relying Party Trust
1. Select AD FS 2.0 > Trust Relationships.

2. Right-click the Coveo Relying Party Trust and then select Edit Claim Rules.

3. Under Issuance Transform Rules:
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a. Create a new Pass Through or Filter Incoming Claims rule.

i. Name = Pass through Windows Account

ii. Incoming Claim Type = Windows Account Name

iii. Pass through all claims values = true

b. Click Finish.

4. Under Issuance Authorization Rules, ensure a Permit Access to All Users rule exists, if not create one.

16.4 Step 4: Editing Claims Rules for the SharePoint Relying Party Trust
1. Select AD FS 2.0 > Trust Relationships.

2. Right-click the SharePoint Relying Party Trust, and then select Edit Claim Rules.

3. Under Issuance Authorization Rules, ensure a Permit Access to All Users rule exists, if not create one.

4. Under Delegation Authorization Rules, add a new Permit Access to All Users rule or choose to permit a
specific user.

5. Under Issuance Transform Rules, for each existing rules of the Relying Party Trust and the Claims Provider
Trust:

a. Click Edit Rule > View Rule Language.

b. If the rule language does not contain a check for Issuer == "AD AUTHORITY", skip to the next existing
rule, otherwise keep going.

c. Copy the rule language.

d. Close the Edit window for the current Rule.

e. Create the new Relying Party Trust rule using the copied rule language:

i. Click Add Rule > Send Claims Using a Custom Rule.

ii. Paste the rule language and replace AD AUTHORITY by SELF AUTHORITY.

16.5 Step 5: Configuring the Coveo Service Account for ADFS Identity
Delegation
1. Log on to Coveo Back-End server.

2. Open the Coveo Administration Tool.

3. Select Configuration > Security > Security Providers, and then click the Claims for SharePoint On-premises
security provider that is used to authenticate to ADFS.

4. In the User Identity box, add the identity of any Windows account that can be used to authenticate to ADFS.
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Note: This account does not require any special permissions on the ADFS server, it is only used to connect to
ADFS when performing delegated authentication.

16.6 Step 6: Performing the First-Time Setup on the Coveo Search Site
Point your browser to the Coveo search site. If the site has been properly configured for Claims, the browser should
now be redirected automatically to the ADFS authentication site, then back to the search site, and then to the first-
time setup page.

In the first-time setup page (see "Coveo .NET Front-End First Time Setup" on page 42), ensure to fill the options in
the Claims section correctly by selecting the claim type that contains the Windows identity
(ex.: http://schemas.microsoft.com/ws/2008/06/identity/claims/windowsaccountname). Upon
completion, the Claims options are saved in the web.config file.

Back to the search page, execute a query. In an interface showing results from a Claims-authenticated source such
as SharePoint, results should now show up. In the same manner, queries in the All Content interface should now
include results from the Claims-authenticated source.
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17. Integrating the Coveo .NET Search Box inMy Site for
SharePoint 2013 and 2016
You can replace the Microsoft search box by the Coveo .NET search box for the My Site pages. On each
SharePoint 2013 and 2016 front-end server, perform the following procedure to edit the template that applies the
changes to the My Site page for all users.

To integrate theCoveo .NET search box in all MySite pages

1. Using an administrator account, log in to the SharePoint 2013 or 2016 front-end server.

2. Enable the Coveo Search Box feature for the My Site pages (see "Activating or Deactivating the Coveo .NET
Search Box in a SharePoint Site" on page 35).

Note: Enabling the Coveo Search Box feature from My Site will not enable it for other pages.

Example: To replace the search boxes in the Home page, you must enable the Coveo Search Box feature
when you click on the Site Setting while being on the Home page.

With SharePoint 2013, enabling the Coveo Search Box feature will unfortunately not be enough to replace all
the Microsoft default search boxes in My Site. You also need to modify three files as described in the following
steps.

3. Using a text editor, open the C:\Program Files\Common Files\Microsoft Shared\Web Server

Extensions\15\TEMPLATE\FEATURES\MySiteUnifiedNavigation\mysite15.master file, and then:

a. At the beginning of the file, after the last existing <%@ Register TagPrefix="... line, add the following
line:

<%@ Register TagPrefix="cessp" Namespace="Coveo.CES.Web.Search.SharePoint.Controls"
Assembly="Coveo.CES.Web.Search.SharePoint, Version=12.0.0.0, Culture=neutral,
PublicKeyToken=44110d16825221f2" %>

b. Towards the end of the file, replace the following code segment:

<div id="searchInputBox">
<SEARCHWC:SearchBoxScriptWebPart runat="server" id="searchInputBox"
DefaultDropdownNodeId="1001" ServerInitialRender="true" UseSharedSettings="true"
ChromeType="none" EmitStyleReference="false"/>
</div>

with the following code segment:

<div id="searchInputBox">
<cessp:SharePointSearchBox runat="server" />

</div>

c. Save the file.

4. Using a text editor, open the C:\Program Files\Common Files\Microsoft Shared\Web Server

Extensions\15\TEMPLATE\SiteTemplates\SPSMSITEHOST\default.aspx file (default location), and
then:
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a. At the beginning of the file, after the last existing <%@ Register TagPrefix="... line, add the following
line:

<%@ Register TagPrefix="cessp" Namespace="Coveo.CES.Web.Search.SharePoint.Controls"
Assembly="Coveo.CES.Web.Search.SharePoint, Version=12.0.0.0, Culture=neutral,
PublicKeyToken=44110d16825221f2" %>

b. Towards the end of the file, replace the following code segment:

<div id="searchInputBox" class="ms-mpSearchBox ms-mysite-searchBox">
<SEARCHWC:SearchBoxScriptWebPart runat="server" id="searchInputBox"

DefaultDropdownNodeId="1003" ServerInitialRender="true" UseSharedSettings="true"
ChromeType="none" EmitStyleReference="false"/>
<SPSWC:MySiteSearchBoxDefaultOverride DefaultId="1003" runat="server" />

</div>

with the following code segment:

<div id="searchInputBox" class="ms-mpSearchBox ms-mysite-searchBox">
<cessp:SharePointSearchBox runat="server" />

</div>

c. Save the file.

5. Using a text editor, open the C:\Program Files\Common Files\Microsoft Shared\Web Server

Extensions\15\TEMPLATE\FEATURES\SocialDataStore\SocialDataStoreList\sites.aspx file
(default location), and then:

a. At the beginning of the file, after the last existing <%@ Register TagPrefix="... line, add the following
line:

<%@ Register TagPrefix="cessp" Namespace="Coveo.CES.Web.Search.SharePoint.Controls"
Assembly="Coveo.CES.Web.Search.SharePoint, Version=12.0.0.0, Culture=neutral,
PublicKeyToken=44110d16825221f2" %>

b. Towards the end of the file, replace the following code segment:

<div class="ms-contentFollowing-searchBox ms-tableCell ms-verticalAlignTop">
<SEARCHWC:SearchBoxScriptWebPart runat="server" id="searchInputBox"

DefaultDropdownNodeId="1001" ServerInitialRender="true" UseSharedSettings="true"
ChromeType="none" EmitStyleReference="false"/>
</div>

with the following code segment:

<div class="ms-contentFollowing-searchBox ms-tableCell ms-
verticalAlignTop"><cessp:SharePointSearchBox runat="server" />
</div>

c. Save the file.

6. Reload the My Site page of a user to verify that the Coveo search box is now appearing in the top navigation
section of the page.

7. Repeat the procedure for each SharePoint 2013 or 2016 front-end server.
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